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Welcome

This was a very ambitious project to cover all the 
new CS4 products. While we didn’t manage to cover 
every application, we got really close. There have been 
many sleepless nights and favor-calling to make this a 
reality. I have managed to assemble a very elite group 
of people, some of the smartest minds in the business. 
Each contributer is an expert (In many cases the top 
expert) in their chosen application.

What you’re holding in your hands (or reading on 
screen) is historic. I don’t think an independant source has 
ever assembled such a complete guide to the realese of an 
Adobe Creative Suite. (Definetly not released at the same 
time as the Adobe announcement!) I really hope you enjoy 
the fruits of our sleepless nights and coffee injections.

A lot of the content here has also been compiled 
into a CS4 microsite at www.PhotoshopCAFE.com/cs4, 
there are also some videos and other goodies there..

Ok, here’s the biggie! This is not only a CS4 guide, 
it is the inaugural issue of a brand-new magazine! Wel-
come to Creative Studio (CAFE)! Ok, I know it’s a bit 
long, but I wanted to keep the word CAFE for now, so 
you know it’s the same people who have brought you 
PhotoshopCAFE.com for almost a decade.

Why a new magazine? There are tons of great maga-
zines out there today. What I always find difficult to 
find is a magazine that inspires as well as educates. 
Creative Studio (CAFE) will be different in that aspect. 
We will be featuring talented people from the Visual 
Arts industry. This will cover design (print and new-
media), photography, video, 3D and illustration. We 
will feature ground-breaking artists and share their 
techniques. You will learn how to work in the real 
world, discover real workflows as well as see inspir-
ing work and lots of tips and tutorials on your favorite 
programs. This will be 
a quarterly publication, 
you’ll download it, it’s 
community minded and 
best of all... It’s free!

Welcome to the new 
future!

Colin Smith 
Publisher
csmith@photoshopCAFE.com

Welcome to this cs4 superguide contributors
David Blater & Anne-Marie Conception: David Blatner and Anne-Marie Concepción are 
regarded as the top InDesign experts and have authored a ton of book and spoken at many events. Together they 
run the top InDesign Resource and magazine InDesignSecrets.com
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good to go otherwise you are almost out of luck. Yes, 
there is hope, you can get a video card and add it to 
your machine. 

The best brand I can recommend are NVIDIA, 
they make cards that start out very cheap, all the way 
up to the high end cards that cost a few thousand 
dollars, for those who have a lot of heavy lifting to do. 
If you skimped and got integrated video, you won’t 
have GPU. You can add a card event to a machine 
with integrated graphics; this is the cheapest way to 
get speed improvements from your machine. See the 
article on GPU later in this guide.

Go to Preferences and choose Performance. You 
will see an option to use Open GL. Turn it on to enable 
the new features, if it’s grayed out, then you don’t have 
a supported GPU.

If you have more than 256 MB of Vram (Video 
Ram) you can take advantage of an accelerator called 
blitpipe.

The first thing you’ll notice is the way documents 
are viewed. You no longer have to zoom into 25%, 
50% etc to get an accurate view.  Everything looks 
great at any magnification; this is a long awaited 
improvement. As you zoom in or out, you will see this 
nice animation as the document zooms, this prevents 
you getting lost in you document. 

When you zoom in, give the document a little 
nudge and release your button, notice it glides a little 
bit, just like “throwing” the document.  This is called 
“flick pan”. If you don’t like this behavior, you can turn 
it off in prefs. (See the website for a video on the GPU 
features as you can’t experience these with still im-
ages: www.photoshopCAFE.com/cs4).

Once you are zoomed in past 500% you will see a 
little grid that separates the pixels. This helps achieve 
pixel accurate editing. You can also zoom into 3200%.

photoshop cs4
By Colin Smith: www.photoshopCAFE.com

When you launch Photoshop CS4 for the very first 
time, something is totally in your face. Yes, it sports 
a brand new interface. Over at Adobe, they have 
decided it’s time for Photoshop to be easier to use and 
make the tools you need within reach. 

The windows version is now running in 64 bit 
mode (allows access to more then 3Gig RAM).  The 
Mac version is still in 32 bit. The reason it’s not 64 
on Mac? At the last moment Apple pulled Carbon 64 
support. It would require a complete rebuild in Cocoa 
for Mac to be in 64 bit which according to my sources 
Adobe is working on for the future. Don’t be alarmed 
by this, there are not that many users that are working 
on images so large they need more than 3 gigs of ram 
anyway. Both Mac and Windows versions are making 
use of the video cards’ GPU , this takes some of the 
strain of the CPU and makes for really speedy graph-
ics and more, while freeing up the CPU to work on 
other tasks..

performance improvements
The new view features are really great. Be warned 

that if you don’t have a video card with GPU (Graph-
ics Processing Unit) you won’t have access to them. 
An easy way to tell is to look at the lower right corner 
of your document. If you see a drop shadow, you are 

Go to Preferences and 
choose Performance. You will 
see an option to use Open 
GL. Turn it on to enable the 
new features, if it’s grayed 
out, then you don’t have a 
supported GPU.
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You also get speed improvements with video play-
back and 3D features using GPU.

interface
On the Mac there is an optional new application 

window. This enables users to float the entire applica-
tion. This now allows users to drag the entire Photo-
shop application to a second monitor or to use the 
program without the desktop showing through. 

tabbed documents

Borrowed from apps such as Flash, Photoshop 
now has tabbed document windows. This allows you 
to manage your working space without document win-
dows spread everywhere. There are options in the new 
Application Bar which allow you to tile the windows 
in different ways, or to float them just like in previous 
versions of Photoshop.

neW panels

Palettes are now called panels across the suite, 
not just in Photoshop. You’ll see some inspiration 
from Lightroom in this release. All the panels have 
been redesigned and there is the addition of a couple 
of new ones; Adjustments and Masks panels.  Don’t 
worry though; most of the panel behavior is the same 
as CS3.

adjustments panel

One of the biggest changes in CS4 is the addition 
of the Adjustments Panel. Adobe is using the modular 
concept from Lightroom. Instead of opening a bunch 
of dialog boxes, you can now work with adjustments 

birds eye vieW

When you are zoomed into the image and want 
to move around, press and hold the H key. Click with 
your mouse and you will zoom out. Reposition the 
viewing rectangle and it will zoom back in to the new 
location. This is a super fast way to get around your 
document. It’s called Birds Eye view and is amazing 
fast.  

The document views are very fast and responsive. 
This is so much better than waiting as your document 
is redrawn line by line! This is especially good for large 
images and panoramas, since only the viewing infor-
mation needed is loaded into the video ram. 

Another GPU improvement is the rotating canvas. 
Hold the R key and drag. You will see a compass and 
the whole canvas rotates for your convenience. This 
is useful for freehand painters using graphics tablets. 
The rotated canvas enables you to draw with the natu-
ral arc of your hand, just like you would spin a piece 
of paper around as you’re drawing on it. The rotation 
doesn’t affect the filters or anything, its not changing 
pixels; it’s only for convenience. For example if your 
page was rotated 30 degrees and you add a 90 degree 
motion blur, it would be 90 degrees in reference to the 
page.

brush improvements

I think by now you’re starting to see the improve-
ments that GPU processing in CS4 gives you. On top 
of that we get a new brush engine, which is faster and 
smoother, especially when working with a graphics 
tablet. You will also notice a new brush preview, and 
wait for it, a new way to resize brushes by dragging 
in the doc. On the Mac hold down Control+Alt (Win-
dows Alt+Right click) click and drag and you will see 
the brush tip change size. Drag to the left or right to 
change the size. Choose Control+Alt+Cmd (Ctrl + Shift 
on Windows) to change the softness.

32bit tone-mapping in hdr

Tonemapping in HDR also gets a boost from the 
GPU and makes for smooth and speedy adjustments 
in the exposure adjustment. Sadly, there are no other 
improvements with HDR tone mapping.
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from a centralized panel. This means all of Photo-
shop’s functionality is available while making image 
adjustments. This is way easier and faster than before. 
A few users are yet to discover adjustment layers, 
now’s your chance to switch. The beauty of this is that 
all the image editing is non-destructive. Shadow/High-
lights and Variations still need to be applied as smart 
filters, but there is an addition of the new Vibrance ad-
justment. Vibrance made its debut in Lightroom. Sadly, 
the clarity slider didn’t make its way across. (These 
are accessible from Camera raw which also works on 
jpg and tiff images – launched from Bridge). To make 
an adjustment, simply choose the desired tool from 
the adjustments panel or use the option at the bot-
tom of the layers panel like before. The difference is 
that a dialog box doesn’t open. You can make all the 
changes with sliders right in the panel. There are also 
options in the panel such as clipping to a single layer.

A really useful addition to the Adjustments panel 
is the ability to easily save and use presets. Sure you 
could save your settings in the past, but it was so ob-
scure it wasn’t really useful. All that has changes, it’s 
now really easy to create and apply presets.

TIP:Typically an adjustment layer will affect the 
entire layer stack. At the bottom right of the panel is 
an option, which affects only a single layer. It does this 
by adding the adjustment as a clipping group to the 
layer directly beneath it. This even works on masks, so 
get your creative thinking caps on!

masks panel

One of the most useful tools when working in 
layers is masks. This allows you to hide or show a 
layers’ content with a brush. Masks are essential for 
any retouching, compositing or collaging. Much of 
the functionality of masks has been moved to a single 
location in an easy to use masks panel. 

Pixel Masks and Vector Masks are both living 
in this new home. Two major features have been 
added. Mask Density and Feather. Density is a fancy 

The Adjustments panel allows you to select an adjustment. Once se-
lected, its options take over the Adjustments panel so you can adjust 
without opening any dialog boxes. When done, click the left facing 
arrow, to return to all adjustments.

Adjustment layers are added to the laters palette just like in the past.
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name for an opacity slider for masks. In the past, more 
advanced Photoshop users used levels or brightness 
adjustments on masks to change they way the work on 
a layer. By deducing the density of the mask, you allow 
some of the masked out portions to come back in a 
controlled way. This is great for making those creative 
little tweaks. For example you want to reduce the ef-
fect of a masked layer rather than remove it, just dial 
back the density and away you go. 

The feather option is a great way to blur a mask 
non-destructively. In the past we applied a blur to the 
mask to soften the edges of a selection for example. 
If we changed our minds later, we had to recreate the 
mask. With the feather options, masks can be blurred 
and we can change our minds or experiment with 
them later. As an added bonus, the feather now allows 
us to apply a soft edged selection to vector masks.

The Masks panel: (Top) A basic mask created to show the red layer through the windows and door.

(Bottom L) The feather turned up, adds a soft edge to the mask. (Bottom Center) In invert buttom has been pressed. This inverts the mask 
and now everything else is red. (Bottom R) Maks density turned down. This lowers the opacity of the mask.

click and drag

In Photoshop CS3, a new behavior was added to 
the black and white adjustment (If you didn’t know, 
now you do). You can click and drag on an image to 
adjust the underlying tones. This Lightroom inspired 
feature is now in the Hue Saturation and curves ad-
justments. Click the little icon and drag on the image 
to make color and tone adjustments, that’s slick!

clone stamp previeW 

The Clone Stamp tool has enjoyed a little bit of a 
tweak. If you have ever seen the brush previews in 
Vanishing point, you will have noticed that the brush 
tip shows what it’s going to paint. This is called a 
clipped preview. We now have the clipped preview on 
the Clone Stamp; this allows us once and for all, to 
perfectly align things while cloning. All the usual com-
forts such as size and opacity controls are included.
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These lenses should be supported with all Canon 
and Nikon DSLRs.

vignette correction

When making panoramas you can also compen-
sate for lens vignette (less light makes it to the edge of 
the lens, therefore the edges of the image are darker). 
This makes the panoramas more seamless without 
dark edges on each photograph.

color range

One of my favorite tools for making selection is 
Color Range. I always had problems with it being too 
greedy and grabbing colors from all over the image. 
It now has a new spatial tolerance with Multiple color 
clusters. What? Ok, in English: Color range has always 
selected by the how close the colors are from each 
other. Now it can be constrained to physical distance 
too, so you don’t have to select a color all over the im-
age, just within a certain distance that you choose with 
the new Range slider which appears when you turn on 
the Localized Color Clusters option.

retouch tools

The Sponge tool has the addition of the vibrance 
control as an alternative option from saturation. 

spring loaded keys 

Here is a tiny, but useful change. Something called 
Spring Loaded keys. How many times have you been 
using a tool and need to temporarily switch to a differ-
ent tool? Rather than tapping a keyboard shortcut for 
the tool, hold the key, use the tool, then release the 
key and you go back to the previous tool. For example, 
you’re working with the brush tool and need to make 
a quick selection. Hold the M key, make the selec-
tion, release the key and continue painting around the 
new selection. Now is a good time to learn all the tool 
shortcuts!

auto align 
When using the Auto-align tool you’ll find some 

minor tweaks. The first is an automatic fisheye correc-
tion. Photoshop will read the metadata and if it finds a 
supported lens, it will compensate for it while building 
seamless panoramas.  
Here are the currently supported lenses.

•	 Canon 15mm Fisheye
•	 Sigma 15mm Fisheye for Nikon and Canon
•	 Sigma 4.5 mm Fisheye for Nikon and Canon
•	 Sigma 8 mm Fisheye for Nikon and Canon
•	 Nikon 10.5 mm Fisheye
•	 Nikon 16 mm Fisheye 

Color Range used to select the blue boat in the photo. 

(Top R) The traditional way

(Bottom R) With the Localized Color Clusters turned on.
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gestures on mac!

I had to try it for myself to believe it! Yes! For those 
of you who have a newer MacBook pro, be happy. 
Those little pinch to scale gestures (ala iPhone) now 
work in Photoshop. That’s just so cool! So cool in fact, 
it works in Bridge too! You can also scroll and rotate 
with the use of 2 fingers.

flash panels 

Adobe had now allowed us to create our own 
panels in Flash and bring them into Photoshop.  If you 
have Flash skills and can build a swf, you can make a 
panel. There is even a Configuration widget that will be 
added in Adobe Labs, this will allow you to make your 
own panels. You can add buttons, commands, movies 
and more. Check out the free custom panels that we 
have on PhotoshopCAFE for your convenience! Just 
drop them into your Panels folder and open them from 
Window>Extensions. 

Photoshop CS4 comes with 2 panels. Kuler (pr- 
cooler) and services (Or connections). Kuler is a color 

Vibrance first found its way into the Adobe world 
through Lightroom. It’s now in Camera Raw and as 
an Adjustment layer. Vibrance works like saturation 
except if avoids clipping colors. When a color is dull it 
gets adjusted more than an already bright color, quite 
nifty really. The Dodge and Burn tools have also been 
tamed a little and are a lot more usable than they 
were in the past. They now affect just the tone without 
messing with the colors.

content aWare scale

Probably the sexiest looking feature in Photoshop 
CS4 is the Content aware scale.  When you transform 
an image vertically or horizontally, usually it ends up 
with a squashed looking distorted image. When you 
turn on Content Aware Scale, it looks for the most 
important parts of the image and maintains their 
shape while squishing everything else. It looks just like 
a magic trick! If Photoshop can’t figure out the impor-
tant parts of the image, you can paint on a channel to 
tell it. There is also a protect skin tones button, which 
prevents skin toned people from getting distorted. 
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extra panels

I have created 
a selections panel, 
which includes all 
the common selec-
tion tools, com-
mands, tips and 
even a little video to 
help you work more 
efficiently with selec-
tions. Keep coming 
back for more, as I 
will be adding more 
free panels for your 
use. Also look for the 
PhotoshopCAFE TV 
Widget coming soon.

connect- noW

Connect Now: File>Share My Screen, allows you 
to share your screen with up to 3 people. This free 
service allows for amazing collaboration, just like being 
in the same room.

annotations

The little notes have been improved. You now have 
a panel for displaying their contents. Much easier to 
work with, plus you can now export the contents as a 
text document. Audio annotations are gone. Yes, they 
had audio annotation, see; no one used them, that’s 
why they are gone.

widget. It helps you choose and match color combina-
tions. Its part of the Adobe Kuler community, where 
you can create and share color palettes. Kuler was in 
Illustrator CS3 and now also in Flash. 

Adobes definition of Kuler: With Kuler, you can 
easily generate color themes that can inspire any 
project. Whether you’re creating web sites, in¬terior 
designs, scrapbooks, fabric patterns, graphic identi-
ties, or any other piece of visual communication, you 
can ex¬periment quickly with color variations. You can 
also fast search by tag word, title, creator, or hex color 
value through thousands of themes created by the 
Kuler community.

Connections: The Connections panel helps you 
manage all your Adobe accounts. It can log you into 
Adobe.com services (Kuler and ConnectNow) as well 
as check for updates and new panels.
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models in high-end programs. They use Photoshop for 
things like creating textures, environment map and for 
compositing into mattes etc. Although the features are 
created to help Professionals, there is also enough to 
keep a novice happy for hours.

model 
You can now create some basic shapes in Pho-

toshop. It has the ability to create primitives such as 
cubes, spheres, pyramids, taurus (donuts), cones and 
other basic meshes such as hats, rings, bottles and 
soda cans. These can have textures applied to them. 

You can also import 3D models from most 3D 
apps, or find them free online at places like Google 3D 
warehouse etc.

photoshop cs4 extended
video

When you choose Enable Timeline Shortcut Keys, 
from the Timelines fly-out menu, the left and right 
arrow keys will advance the video forward/back by a 
single frame. Holding shift makes it move by 1 second 
at a time. If there are no animations in the document, 
the arrows revert to their nudging behavior.

Photoshop now moves on from silent films and 
supports sound with videos. You can preview and 
export sound with your videos. 

3d
All I can say is 3D is huge in Photoshop CS4. 

Adobe added 3D layer abilities in CS3 but these were 
nothing compared to what’s possible now. 

mission

Photoshop is not trying to replace your current 3D 
application. The people at Adobe have recognized the 
workflow of 3D artists and have made the updates 
in Photoshop to help them. Most people create their 

3D panel (From Left). Scene: Where you control the rendering, painting and other global settings. 
Lights: Control and create lights. Materials: Control the textures. Mesh: Where you control the models.

The 3D Widget (Avaliable only 
on GPU supported machine). 

This allows you to rotate, scale 
and move your 3D object. You 
can change the size and loca-
tion of the Widget.
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lighting 
There is a new 3D scene panel that controls 

features like meshes (shapes), lights and materials 
(textures) and even environments (used for reflec-
tions). There is a lighting widget where you can choose 
between 3 different types of lights and change proper-
ties such as fall-off and shadow.

render
Photoshop CS4 Extended comes with new render 

settings including ray tracing for better quality renders. 

animation

We now have the ability to animate the shapes and 
cameras. This is a huge addition to Photoshop extend-
ed. Not only can you animate the shapes themselves, 
you can animate the textures and even apply video to 
them. If you want to do 3D animation sin After Effects 
or Flash, you can create them in Photoshop, import 
them to After Effects and then output them to Flash. 
All the render and animation properties are controlled 
from Photoshop and then updated in After Effects as a 
Photoshop 3D layer. This makes for some very eye-
popping possibilities!

Colin Smith is a best selling author, digital artist, speaker and 
creates popular training videos. He is founder of PhotoshopCAFE.
com.

Photoshop allows you to position, scale and rotate 
3D objects, but does not have any features to allow 
you to directly manipulate the shapes. If you want to 
do this, check out the Plugin-ins from Strata,( http://
store.strata.com/?Click=4867)  that allow that kind of 
extended functionality.

texture 
Photoshop CS4 has really stepped up to the plate 

with the texturing features.

3d object painting

You can paint directly onto your 3D surfaces and 
they will actually be applied to the models. There are 
different ways of painting. You can do a basic diffuse 
which is just like painting onto a 3D object. You can 
use bump, which will actually etch into the surface for 
a 3D looking texture. There are other things like glossi-
ness, self illumination, reflectivity and shininess which 
all effect the lighting and the way the shape responds 
to it. You can also paint on opacity, which allows you to 
paint on portions of transparency or semi-transparency 
to your objects. These features are deceivingly power-
ful. You can still unwrap the textures and apply photos, 
or your own designs as textures and enviroments.
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With the launch of its new Adobe Photoshop CS4, 
Adobe Systems Inc. is the latest in a trend of visual 
computing companies grabbing on to the massively 
parallel processing power of GPUs for more than just 
rendering pixels to the screen. With GPU acceleration, 
Photoshop CS4 enables a faster, more natural way 
of working with images, while improving quality and 
productivity. The latest edition in a long line of award-
winning tool suites, Adobe Creative Suite 4 is the first 
application set of its kind to take advantage of the power 
of native GPU acceleration.

What does this mean for you? It means that with an 
GPU, Photoshop CS4 is faster than ever. It will be easier 
to manipulate and handle your images and you will spend 
less time waiting for your computer to finish a task. You 
don’t need to have a GPU in your machine to use Photo-
shop CS4, but it will unlock certian features and speed.

With consumer digital cameras routinely being of-
fered with five or six megapixels and professional cam-
eras producing 12 megapixel or higher images, digital 
pictures are growing bigger and bigger and take more 
and more processing power to process and display. 
Adding a GPU, or upgrading your existing GPU to one 
supported by Photoshop CS4, may be the single most 
important step you can take toward better performance 
with Photoshop CS4.

Photoshop CS4 detects the presence of a GPU and auto-
matically turns on the accelerated image handling features: 

•	 Canvas rotation—the new Rotate View tool is instanta-
neous and smooth. There’s no need to manually set the im-
age rotation angle; simply grab and spin it to any orienta-
tion you want, all with no waiting.

•	 Zooming—no stuttering or preview lags, just speedy zoom-
ing in and out of all file sizes, big and small. 

•	 Flick panning—use the Hand tool to “toss” images across 
the screen for a natural, real-time pan in any direction.

•	 Fast antialiasing—when adding text or objects to your 
photos, jagged edges become a thing of the past. 

•	 Brush resizing—simply drag your mouse to resize brushes, 
preview brush strokes before you make them, and 
experience higher precision tablet tracking.

•	 Other features accelerated by NVIDIA 
graphics include Photoshop 3D 
movement, high-dynamic-
range tone mapping, and 
color conversion.

What is a gpu?
A GPU is a massively parallel graphics proces-

sor that is responsible for the visual experiences on 
PCs, notebooks, workstations, cell phones, and game 
consoles. NVIDIA GPUs are some of the most complex 
processors ever built, and feature up to 240 individual 
processor cores that not only power high resolution 
gaming experiences, but also high definition movie 
playback, photo, map, and web applications, video en-
coding and transcoding tasks, and rich user interfac-
es. Companies like Adobe have started to tap into the 
massive parallel processing power of GPU’s to enable 
more intuitive and natural ways of working with images 
as well as to decrease the 
amount of time it take 
to do processor 
intensive tasks 
like pre-
viewing and 
encoding video.

Windows Memory User Price Est.

GeForce 9400GT       512Mb       Entry $59
GeForce 9500GT 256/512Mb Entry $70
GeForce 9600GT 512Mb Mid $210
GeForce 9800GT 512Mb Mid $229 
GeForce GTX 260 896Mb Pro $422
GeForce GTX 280 1Gb Pro $499

MAC Memory User Price Est.
GeForce 8800GT 512 MB Mid $299
GeForce 8600M 
GT

256/512 MB Macbook Pro N/A

Quadro FX 5600 1.5 Gb Pro $2,999
Entry: Single displays and work with smaller file sizes.
Mid: Work with dual monitors or higher resolution image (most photoshop CS4 Users).
Pro: Multiple high resolution displays and very high resolution images (Photoshop 
CS4, Premier CS4, and After Effects CS4 power users. )

gpus poWer the creative revolution With adobe cs4 
Jim Black - NVIDIA

Jim Black is the Director of Worldwide Technology 
Evangelism, responsible for ensuring technical 
alignment between NVIDIA and strategic devel-
oper partners.   Jim joined NVIDIA in February 
2000, prior to that he was a product manager for 
both Apple and Netscape.  He holds  B.A. and J.D. 
degrees from Wake Forest University.
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a little exposure to your photo, increase the contrast 
a touch, or pump up the saturation a bit.  These are 
familiar sliders to those who have worked in Camera 
Raw before.  But what happens if you want to just 
lighten a face or darken only a sky?  You now need to 
apply Local Adjustments.

There are two new tools in Camera Raw that allow 
you to work locally on your images, the Graduated 
Filter and the Adjustment Brush shown highlighted 
in red in Fig. 1.2.  These tools allow you to target a 

certain area and then apply a change of Exposure, 
Brightness, Contrast, Saturation, Clarity, or Sharpness 
to that area only.  You can even overlay a color locally 
with these tools!

using the local adjustment brush

So now that you know what these tools can do, 
let’s look at how to use them.  Fig. 1.3 shows the Raw 
Converter with an underexposed image open.  I have 
clicked on the Adjustment brush so the panel on the 
right hand side now reflects the options that apply to 
that tool.  When you mouse over your image, you can 
see that you have the adjustment Brush all ready to 
go-Fig. 1.4.

The goal here is to first:

Define what you would like to do the area-add 
brightness or contrast 

Then define the area that you want affect. 

Step 1 starts with making your adjustments on 
the right hand panel.  I will start by bumping up the 

camera raW 5
Tim Cooper - timcooperphotography.com

the neW local adjustments in 
camera raW

Adobe just keeps making the Raw Converter better 
and better.  With the newest version (Adobe Camera 
Raw 5.0), we now have the ability to locally edit our 
Raw images! Imagine being able to dodge and burn 
without using layers, or darken a sky without going 
even going into Photoshop. The folks at Adobe have 
conceived a system that allows us to locally edit our 
images right in the Camera Raw dialog box.  Couple 
this with the use of smart objects and we have more 
power and control over our photographs than ever 
before.

local adjustments

Photographers have been altering their images 
since the dawn of photography. A little lighting here, 
some darkening there, changing the contrast of their 
printing paper, using a filter under the enlarger lens 
or choosing a longer exposure time.  These methods 
were common darkroom practice.  With the advent 
of digital imaging, these practices have not so much 
changed as just become easier.  

There are two types of changes 
we can make to our images.  Those 
that affect the entire image (global 
adjustments) and those that affects 
only certain areas of the image (Lo-
cal Adjustments). When you open 
an image in Camera Raw and begin 
working with the Basic Tab (Fig. 
1.1) you are adjusting the entire 
image.  You are applying Global Ad-
justments.  This is, of course, is the 
necessary first step.  You may add 
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Feather- This determines how soft the brush edge 
will be.  A higher number gives you a softer brush so 
that your adjustment feathers out, a lower number 
gives you a harder brush. Fig. 1.9 shows a low feather 
of 12 and the corresponding mask it creates and Fig. 
1.10 shows a high feather of 54 and its mask.  Most 
of the time when painting in a local adjustment, you 
want your brush feathered.  Rarely will you use a hard 
edged brush.

Flow- This slider controls the rate of application 
of the adjustment, or how much comes out when 
you’re painting.  A low flow rate will keep building up 
to the max density you have set in your density slider.  
Keep this setting at 100 if you are using a mouse and 
experiment with it if you are using a pressure sensitive 
tablet.

Density- controls how much opacity there will be 
total. Keep this setting at 100 if you are using a mouse 
and experiment with it if you are using a pressure 
sensitive tablet.  If the Density is set to 100, then you 
get 100% of your adjustment coming through on your 
image.  This is where I recommend beginning.  It is 
easier to paint a 100% density mask and then control 
the amount of your adjustment through the Exposure, 
Brightness, Contrast, etc. sliders.

Auto Mask- When checked, this box attempts to 
control the brush strokes to areas of similar color.

multiple local adjustments

The Raw Converter also allows us to have multiple 
masks, defining different areas.  I have a grayscale 
image that I would like to fix both the door and the 
stairs, but each separately.  Each area needs slightly 
different adjustments.  I begin by clicking the Adjust-
ments brush. Notice that the new button is checked 
by default.  This means I will be starting a new mask 
with the adjustments that are currently set.

exposure to +1.00.  At first I will not know how much 
to add, but we can fine tune that later.

Step 2 simply requires you to paint over the area 
that you want to affect.  The additional exposure is 
added to that area as you paint.  I have increased the 
exposures slider and finished painting in the other 
face. 

As you define the area, you are actually painting 
a mask with the paintbrush.  By checking the Show 
Mask box you get a visual of where you are paint-
ing as seen in Fig. 1.7.  Uncheck the box to remove 
the mask overlay.  To change the mask color, double 
click on the color box next to the Show Mask box and 
choose a new color.

The overall effectiveness of your local adjustment is 
going to largely depend on how your paint your mask.  
Fig. 1.8 shows section of the panel that governs your 
paintbrush as you paint.

Size- Controls the overall size of the brush.  For 
those of you who wish to use the keyboard shortcuts 
instead, Left Bracket key shrinks the size or Right 
Bracket Key enlarges the size.
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mask.  Fig. 1.14 shows the new mask after it has been 
painted.  Now there is a new Pin.  This pin indicates 
the stairs mask.  It now has the black dot in it.  The 
door mask Pin is solid and uncolored.  This indicates 
that it is inactive.  Whether I am painting or moving 
sliders in the adjustment panel, the effects will take 
place on the active mask-the one with the black center 
dot. Returning to the adjustment panel I increased my 
exposure to 2.60 and lowered my brightness to -67 so 
I would lighten the mortar between the stones without 
significantly brightening the stones themselves.

If I wanted to return to the door mask, I simply click 
on the pin for that mask. The mask temporarily shows, 
and the pin gets the black dot.  Now my adjustments 
apply to that mask.  I move my exposure up to +1.45 
to make the door a touch brighter.  Fig. 1.15 shows the 
finished image.  To leave the Adjustment Brush mode, 

simply click on any other 
tool.  Your Local Adjust-
ments are written in to that 
image and you are ready to 
proceed with Global adjust-
ments once again.  When 
you are finished editing your 
image  press Done to save 
your changes and close the 
file.  Press Open Image to 
open the file into Photoshop 
for further editing.    

a couple of other hints:

Checking the Show Pins box allows you to view the 
pins (recommended).  If you turn this off you might 
not know which mask you are working on!

When you are working with the Adjustments brush, 
the preview button turns on and off the local adjust-
ments only.  All other global adjustments stay as they 
were when you entered this area.

Double clicking on any of the sliders, returns them 
to the zero position.

If all of your sliders are at the zero position, you 
cannot create a new mask.  One of the values must be 
changed to start painting a new mask.

I set the adjustments to 
+1.25 Exposure and +100 
Contrast and painted in the 
door.  Notice in Fig. 1.12 
the small green circle with a 
black dot in it?  This is called 
a Pin.  This Pin lets me 
know that I am working on 
the door mask.  After paint-
ing, the door looks much 
more alive.  The bump in 
contrast and exposure has 

brought out more of the details.

Now to fix the stairs.  
In Fig. 1.13 I have clicked 
on the New button.  This 
lets me start a new mask.  
Notice that my settings 
have not changed.  These 
settings are Sticky so they 
always revert back to the 
last settings used.  I will 
go ahead and begin paint-
ing using these settings 
and then return to them 
later to adjust if necessary.  
As soon as you begin to 
paint, the New button 
returns to the Add button.  
So if you stop painting 

and begin again, you are still painting on the same 
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my exposure and raised my contrast to get the pop I 
was looking for in the sky.  Fig 1.18.  Looks pretty good 
but we can make it better.  The bottom of the gradient 
does not align with the hillside.  

 To rotate the gradient, move your mouse over the 
line of the gradient and push up or down as seen in 
Fig. 1.19.  

To move the bottom line upward click on the red 
circle and push up.  

To move the 
top line downward, 
click on the green 
circle and push 
down.

Remember 
that what you are 
actually drawing is 
the gradient itself.  
Everything above 
the Green circle is 
receiving the full 
adjustment, and 
everything below 
the red circle is re-

ceiving no adjustment at all. The adjustment decreas-
es in intensity from the green line down to the red 
line.  So in Fig. 1.20 you can see that I am lowering 
my green line so that I am adding more of the darken-
ing adjustment lower in the sky.   This has the effect 
of shortening the gradient.  Going too far with this can 
make your transition zone (gradient) more obvious.

Much like the Adjustment Brush, you can create 
more than one gradient in your image.  Simply click 
on the new button and draw another.  In the case of 

Check the Eraser radio button and paint to remove 
the effect from that area (you are removing the mask)

You can paint different densities on the same 
mask.  Begin by painting at 100% Density.  If you want 
to add the same adjustment to other places on the im-
age, but not quite as strong, simply lower the density 
and paint them in.

Pressing Command+Z (PC-CTL+Z) will undo 
your last step in working with the Adjustment Brush.  
Pressing Command+Opt+Z (PC-CTL+Alt+Z) will keep 
stepping you back in time through all of your edits with 
the Adjustment Brush.

the graduated filter

The other great local adjustment tool to find its 
way into the Adobe Camera RAW 5.0 is the Graduated 
Filter.  Fig. 1.16 shows the Raw box open with Gradu-
ated Filter tool selected.  

The Graduated Filter tool works very similar to the 
old Split Neutral Density Filters-except much, much 
better.  This tool gives us complete control over our 
filter.  You can use this tool when you want to darken, 
lighten, and change contrast or color in a large part of 
the image.  The image in Fig. 1.16 is a perfect candi-
date for this tool.  Here I want to darken down the sky 
to give it more punch.

With the Graduated Filter selected, I can see the 
now familiar sliders to the right.  I will use the expo-
sure slider to darken down the sky.  I click at the top of 
the image and start to draw down to the center of the 
image.  This draws out the gradient and reveals the 
darkening from the lowered exposure.  Now I have the 
chance to readdress the sliders.  In this case I lowered 
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Click the Show Overlay box to hide and show the 
overlays.  It is often easier to adjust the sliders when 
they are not present.

You can pull either the red end or green end off of 
the canvas to get an even smoother gradient.

Double clicking on the color box brings up a box 
where you can choose a color.  This color will be over-
laid in the gradient.  This can be good when you want 
to warm up a foreground or add color into the sky.  Be 
careful.  Use the saturation slider at the bottom of the 
box so that your effect is not too garish.

You can use the gradient tool sideways as well!  
Same technique, just drag sideways.

The Preview box only toggles on and off the Gradi-
ent effect when you have this tool selected.  It will not 
turn on and off the global settings.

The Clear all button does just what you think it will:  
Remove all of the gradients you have created.

Pressing Command+Z (PC-CTL+Z) will undo 
your last step in working with the gradient.  Pressing 
Command+Opt+Z (PC-CTL+Alt+Z) will keep stepping 
you back in time through all of your edits to the gradi-
ent.

The plus and minus buttons on either side of the 
sliders will move your slider in either .25 or .50 jumps.

Tim Cooper is an author and photographer. He travels the nation 
teaching Photographers through Rocky Mountain School Of 
Photography. He is author of the Perfect Exposure and Perfect 
Composition training videos (PhotoshopCAFE.com) 
timcooperphotography.com

Fig. 1.21, I will draw a gradient from the bottom up to 
saturate the foreground and increase contrast.  You 
will notice that your first gradient has mostly disap-
peared and is now represented by white circles.  It 
is no longer active.  This means the effect of it is still 
present, but you are no longer editing it.  The new (ac-
tive) gradient has the red and green circles.  If I made 
any further adjustments to the sliders, it would apply 
to this new gradient.

You are free to combine the affects of the gradient 
tool and the local adjustment tool in one image.  In 
Fig. 1.22 I have clicked on the Adjustment Brush and 
lightened up the rock a little.  I then lowered the den-
sity on my brush and painted the yellow flowers.  This 
allowed a little of the lightening through but not 100%.  

When you are finished editing your image press 
Done to save your changes and close the file.  Press 
Open Image to open the file into Photoshop for further 
editing.    Fig. 1.23 shows the before and after.

a couple of other hints:

Holding down the shift key while dragging the 
gradient keeps the gradient traveling in a straight line.  
It is much easier to do this first.  To rotate, move your 
cursor over the line until it becomes the curved arrow.  
Now rotate.  This gives you much more control.  

If you decide that you do not like a gradient, while 
it is active (red and green), just hit the delete key to 
get rid of it.

To activate a gradient when it is displayed by white 
circles, click on one of the circles.
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Save 10% use code CSC808
www.PhotoshopCAFE.com/video

T H E  U L T I M A T E  I N  P H O T O S H O P  T R A I N I N G

A DOZEN OTHER TITLES 
See website!NEW! 

All new for Lightroom 2. This is the most com-
prehensive video on the market for Lightroom. 
Learn how to import, organize, develop and 
output all your captures with effortless ease. 
Enjoy in-depth coverage, pro techniques, secret 
tips and Colin’s way of breaking down even 
the most complex tasks into quick and easy to 
understand techniques. You’ll spend less time 
in front of the computer and more time behind 
the camera!  7 hours.

The most comprehensive video  
available for Lightroom 2

Have you ever looked at a stunning HDR image 
and wondered, “how did they do that?” This 
video will serve as your easy to follow and 
informative guide to the world of HDR. When 
used correctly the 32 bit tools in Photoshop 
will enable you to create drop-dead gorgeous 
images with effortless ease. Learn some 
clever tricks that will enable you to boost the 
dynamic punch of Low Dynamic images. You’ll 
be able to supercharge any image with this 
bag of tricks in your arsenal. 90 mins.

Learn how to extend the dynamic 
range of any Photograph!

This video teaches you how to transform 
your photography! Your images will instantly 
become more powerful and engaging. In addi-
tion to teaching you the rules of composition, 
Tim shows you why the rules work, and when 
to break them! This video takes you through 
the steps of seeing, designing, and executing 
the final composition. Learn how your shutter 
speeds, f-stops, and lens length are crucial 
to composing your photo. Never take a boring 
shot again.  90 mins.

Go from taking snapshots to cap-
turing photographs.
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If you are a beginner at 3D modeling and textur-
ing, CS4 will help you get familiar with the basic tools 
and texturing capabilities through its intuitive inter-
face.  Primitives are basic 3D shapes such as spheres, 
cylinders or cubes to name a few.  Essentially, CS4 will 
take any image and place it onto the primitive that you 
choose.     In this example I have chosen a Cube. Let’s 
learn how to navigate a 3D object.

Take a look at your tools bar and notice that we 
have something new.  You will see a toolset for navigat-
ing 3D objects imported into CS4.  There are two sets 
of tools.  One set is for the navigation of the object and 
the other is for the navigation of your camera.  

Navigational tools for the 3D object

Navigation tools 
for your camera

basic 3d navigations

When you select any navigational tool a 3D Axis 
guide automatically appears adjacent to your model 
that has red, green and blue color designations.  
These correspond to X, Y and Z axis.  On a grid the 
“X” axis (red) is simply a movement going from left to 
right.  The Y axis (green) is a movement going up or 
down.  And finally, the Z axis (blue) is movement going 
in or out into the scene.

Access the 3D menu

step 1.
If you place your mouse on a circular shape for any 

of the axis take notice that a ringed shape will appear 
that designates the direction which you will be re-
stricted to.  When you rotate automatically a dark blue 
highlight will display the position where you began and 
where the position ends.

photoshop cs4 and 3d
Stephen Burns - www.chromeallusion.com 

Adobe is bridging the gap between two dimen-
sional and 3 dimensional approaches to creating art.  
It started with CS3 where we have the ability to import 
3D objects into 3D Layers and have some of the same 
navigational functionalities as 3rd party 3D program.  
In addition, we can access the textures via the use 
of Texture Layers.  This gives us the flexibility to alter 
them to match our final vision in post production.

Now we have the long awaited Photoshop CS4 
that has upgraded its 3D capabilities greatly from its 
predecessor.  Its 3D engine goes beyond reading the 
object and its textures.  It will allow you to import & 
add lights to your 3D scene.  It will also read and apply 
Glossiness, Specularity, Bump and Reflection maps.  
Photoshop reads its texture information off of UV maps 
(U –Horizontal and V-Vertical).   These are basically 
2 dimensional images maps that are mapped onto 3 
dimensional surfaces.  This style of surface mapping 
allows the most flexibility as to where you apply your 
textures.  

In this tutorial we are going to explore UV mapping 
in a 3D program and import the 3D object into CS4’s 
3D Layers.  Then we will discover the great flexibility 
that we have with the new advances to the texturing 
engine.

Let’s start with the 
basic 3D options for 
creating 3D primitives 
from single or multiple 
images.  You can ac-
cess this under the 3D 
options located on your 
menu bar.  So, Open 

any image and select the Cube option to create a 3D 
cube.

Access the 3D menu
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that location on the UV map that is designated to the 
window’s rims and paint that area black.  When the 
map is reapplied to your 3D object your window rims 
will take on that color.  This painting or editing is done 
in any two dimensional digital paint program which in 
this case is CS4.

Example of UV map 
with texture of subma-
rines body

Take a look at figure 10 and you will see the 
top view (top left), side view (bottom right) and the 
perspective view (top right) of the submarine.  On the 
bottom, left hand corner you will see the  UV map for 
the submarine’s body.  Let’s define further where that 
is.  The egg shaped cockpit on the left hand side of 
the model is designated as the submarine’s body.  

Figure 10: 3D model 
displayed in LightWave

Figure 11 shows the 
panel that displays all 
of the textures for this 
sub.  Please take note 
of them because when 
we go into Photoshop 
you will see these 
names applied again.

Fig 11: View of LightWaves 
texture panel

Next, if you place your mouse directly on the cubic 
shape located at the end of each of the axis you will 
resize the shape of your object along that axis.

Place your mouse on the larger cubic shape where 
all of the axis connects.  If you click and drag here the 
entire object resizes without distortion.

Finally, you can shift your object along a desig-
nated plane.  This places your mouse on the plane 
between two axes allowing you to drag your mouse.

Now that you have a basic idea how to navigate 
your 3D object let’s take a look at a 3D object that was 
created in NewTek’s Lightwave (www.newtek.com ).  
We will examine how to bring in Third-Party 3D models 
into Photoshop’s 3D layers.

 importing third-party models

Take a look at figure nine.  What you’re looking at 
is a texture laid over UV coordinates for the body of a 
submarine created in LightWave.  UV coordinates are 
simply the surface of the 3D object that has been un-
wrapped and laid out like a flat sheet of paper so that 
we can draw or paint on it.  When you are completed 
with drawing or painting on this paper we can then 
wrap it back on to our object to display the new edits 
that are accurately placed.  For example if we want 
the rims of the windows to be black we simply find 

Reposition your object along a 
designated plane

Resize along all axis

Stretch along a designated axisRotation along a designated 
axis
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Display of the 
texture for the body 
of the ship

This texture can be edited like any image in Photo-
shop.  In this example a yellow stripe has been applied 
around the base of the windows.  After the stripe is 
applied all you need to do is hit Ctrl S/Cmd S to update 
the model.

Yellow stripe applied to the model

Figure 16 shows the visual 
result of the model in Photoshop.

Fig 16  Update the texture on the 
model

The technique that I have shown you works well 
but is an old technique from CS3.  CS4 has been 
updated to take advantage of the paint tools.  In other 
words we can utilize our Paintbrush to paint directly 
onto the model.  This feature is really going to revo-
lutionize the workflow of 3D modelers and concept 
artists.

To start it is important to open up your 3D Palette.  
Near the bottom of the palette you will see an option 
that says ‘Paint On’.  Make sure that ‘Diffuse’ is se-
lected.  This option simply allows you to paint directly 
on the surface of the texture within that particular 
layer.

importing your model into photoshop

Let’s go back into Photoshop and import the model 
that was created in LightWave.  It is important to know 
that Photoshop will read several formats natively that 
include the following:

3DS

Obj

DAE

KMZ

U3D

Depending on your software of choice, check with 
the manufacturer to find out if they have created a 
plug-in for Photoshop that will read and import the 
application’s models and textures.  In this example the 
LWO Importer can be downloaded from NewTek’s site 
(www.newtek.com).

To import any 3D object into Photoshop’s 3D layer 
access your 3D menu and “new layers from 3D file”

Import object into Photo-
shop’s 3D layers

Once the object is imported you will see in your 
Layers Palette not only the thumbnail of the model 
but the textures that have been applied to it through 
LightWave as well.

Display of the imported model from LightWave

If you double click on the texture as a designated 
body automatically the texture will open up into its own file.
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All of the information that we paint on the ship will 
be applied directly to the new layer that we created as 
shown in figure 22.

3d panel options 

CS4 has given us other powerful tools for viewing 
and editing the surfaces on the objects.  The 3D panel 
is divided into 4 sections which are 3D Scenes, 3D 
Mesh, 3D Materials and 3D lights. 

let’s begin With 3d scenes.

One of the 3D scenes feature is to give you a visual 
representation of the model in a number of styles. We 
will look at only 3 of those but experiment with the 
others on your own.  Take a look at Figure 23 thru 25.  
The Bounding Box options simply places an outline of 
a cube as a representation of the more sophisticated 
shape.  The Shaded Wireframe displays the edges of 
the polygons that make up the model.  Raytracing rep-

Experiment with 
these basic shapes to 
get to know how images 
are mapped onto their 
surfaces.  Simply open a 
bitmap image in win this 
particular

Set ‘Paint On’ to ‘diffuse’

I recommend that you apply the next procedure to 
all of your layers because as you are painting on your 
model you’re going to want the entire object to have 
the ability to acccept paint.  In order for your object 
to accept editing from the Paint Brush you need to 
have a layer that will accept bitmap information.  Next 
click on a layer that designates the texture that you are 
interested in editing.  Create a brand new layer above 
the one that’s already there as shown in figure 18.

Place a new layer above your 
texture

Now you’re ready to begin painting.  Just select 
your paintbrush with any color that you choose as your 
foreground color and begin applying it directly to the 
object.  Don’t forget to use your navigational tools to 
move, rotate and pan your object.  Figure’s 19 through 
21 shows examples of the surface of the submarine 

edited with the 
paint brush 
as well as the 
smudge brush.  

Paint directly onto 
the model

Additional paint 
being applied to 
the model

Fig 22: Textures are applied 
to the Blank layer that we 
created
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resents the final render.  Take notice that Raytracing 
actually displays the reflections as well as the shadow 
details.

The next button is for your 3D Mesh options.  Here 
you can use all of the navigational tools to position, ro-
tate, scale and move your object.  In addition you can 
choose to Cast Shadows or catch shadow from itself or 
other objects.

 

View of the 3D Mesh Panel

Now, take look at your 3D Materials option.  This 
is where you can modify and add Bump Maps, 
Glossiness, Shininess, Opacity and Reflectivity.  In 
this example the ‘windows’ material is chose and its 
Reflectivity is up to 64%.  As a result you can see the 

reflections 
from the 
subma-
rines side.

Reflectivity 
applied to 
64%

(L) View of the shaded wire option 

applied to model. 
(Lower L) View of the Raytracing 
option applied to model.  

(Lower R) View of the Shaded Wire 
frame option applied to model

Figure 28 shows the Reflectivity set to ‘0’.  Now 
reflections are no longer applied.

Reflectivity 
applied to 
0%

applying the altering lights

One of the more powerful features in CS4 is the 
ability to add, manipulate and move lights through the 
document.  To see the lights themselves in your docu-
ment you must turn on their visibility which is an icon 
at the bottom of the 3D Lights palette. Let’s start by 
taking a look at controlling shadows.

Figure 29 shows the Softness option set to 0%.  
Take note of the hard edge of the shadow.  

Figure 30 shows the Softness option set to 65%.  
Here the edge of the shadow is soft and pleasing.    

Softness set to 0%                                Softness set to 65%

There are several types of light source in your 
scene. As a default you have 3 light sources automati-
cally applied to your scene and they all will be Infinite 
light sources.  You can alter these lights to other styles 
just by selecting the style from the drop menu as 
shown in figure 31.  Your choices are Spot, Infinite 
and Global.  Spot is more directional where you can 
change its falloff and direction.  Infinite is a broader 
light source that is still directional.  Global emits illumi-
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Once you have finished updating the surfaces on 
your model then you are ready to use it for a concept 
piece.  The final image shows the textured sub as part 
of an underwater environment. So, the galaxy is truly 
the limit in CS4.  

I hope that you enjoyed this article.  Keep an eye 
out for my new book “The Art of Poser Pro and Photo-
shop CS4” where we will explore some artistic oppor-
tunities with Photoshop CS4 Extended and Poser Pro.

Stephen Burns has authored several book on Photoshop and 
digital art. He is a popular artist and runs of the world’s largest 
Photoshop User Groups. www.chromeallusion.com

nation in all direction.  Figure 31 shows the spot light 
positioned for illuminating the top of the sub.

31:Spot Light 
illuminating 
the sub

You also, have the option to alter the color to match 
the lighting in your scene.

bump maps

Once the lighting is set up correctly then it’s time to 
bring in your bump maps to really add some character 
and detail to your model and it’s easy to do.  Just keep 
in mind that 3D engines utilize black and white infor-
mation to create the bump.  The highlights give the 
surface the appearance of rising forward and darker 
tonalities makes the surface recede.

To apply a bump map go to your Materials panel 
and next to the Bump Strength then select Load Tex-
ture from the drop list.  

Load a new 
texture dialogue 
box

View of the 
bitmap used to 
create the bump

The material for the body of the sub was originally 
chosen so ‘body bump’ designates that it’s the map for 
that surface.  Figure 35 shows the completed results.

Fig 35
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has provided via the menu dropdown. The default is 
aptly named Essentials and depending on your task at 
hand, Animator, Classic, Debug, Designer, and Devel-
oper are within quick and easy reach.

neW panels

Allow me to introduce you to the brand new Mo-
tion Editor panel, a powerful new tool that provides 
full control of each individual property of animated 
objects. Think of the Motion Editor as the Timeline 
panel’s older brother. We’ll discover its power later on.

Kuler is now integrated into Flash CS4! The well 
known and highly praised web-based color mixing 
application from Adobe is now within easy reach as its 
own Flash CS4 panel. Very “kool”!

The Motion Presets panel (another one of my new 
favorites) provides easy access and management of 
default and custom saved animations. This means 
anyone can save an animation as a preset and apply it 
to another object with the click of a button. This allow 

flash cs4
Chris Georgenes

On first launch of Flash CS4, you’ll find what I 
regard as a smart and mature interface. It is amazing 
to think this is the same program as version 3 when I 
first discovered it.  There are no major changes to the 
interface in Flash CS4, it will still look familiar to you if 
you are coming from previous versions. What changed 
are several subtle refinements to the overall look and 
feel. Most notably is the new Properties panel – for the 
first time ever, it is vertical! 

Personally this is a major improvement because 
I have never been able to find a happy home for the 
older horizontal Properties panel. I use a high a display 
resolution as physically possible (1920x1200 mini-
mum) and docking the older Properties panel created 
a lot of empty panel space. Having it undocked forced 
me to constantly move it around as I worked. Now 
with CS4, the vertical Properties panel docks perfectly 

along with the rest of the 
panels.

Like previous ver-
sions, you can create and 
save your own custom 
workspaces, but you may 
not even need to with the 
new array of well thought 
workspace designs Adobe 
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This path is easily modified with Bezier handles and 
timing can be adjusted throughout an animation with-
out having to manually insert keyframes in the timeline 
which would break a “classic” tween. 

Knowing that the new object-based Motion Model 
will break any and all previous workflows, Adobe has 
retained the previous method of motion tween via 
the right click context menu. It is now appropriately 
named “Classic Tween”. Thanks Adobe for listening 
and realizing that having 2 options is always better 
than 1.

Motion Editor

If the Timeline panel is used to make your bigger 
brush strokes, then the Motion Editor is used for your 
smaller and more detailed brush strokes. The Motion 
Editor is a powerful new panel that provides fine-
tuning of your animations. This is as close to an After 
Effects timeline as Flash has ever been. Here you can 
easily edit and control animations across individual 
properties without touching the Timeline panel. You 
now have complete freedom to adjust parameters 
such as rotation, size, color, and more within a tween. 

The first category of properties is Basic motion. 
Here you can fine-tune the position of your object 
based on its “X”, “Y” and “Rotation Z” axis.  The 
second category is Transformation, allowing you to 
control the Skew and Scale of your object along it’s “X” 
and “Y” axis. Each property has its own hot text slider 
for quick and easy adjustments as well as the ability to 
add and remove keyframes. 

There is also an Eases category that provides a 
list of preset eases and the option to create your own 

you to build vast libraries of reusable animations and 
save hours of valuable production time. It also sup-
ports import and export of presets for sharing across 
teams.

motion model (object-based animation)

For those of you who have ever used Flash for 
animation, then you are probably familiar with Motion 
Tweens, a Flash animation staple since the dawn of 
time. Motion tweening has always been a very straight-
forward and simple process. The tween essentially 
interpolated animation between 2 keyframes. This 
interpolation was based on changes to the object’s 
properties (position, scale, color effect, etc.). What was 
limiting about the Motion Tween was that it was frame-
based, hindering the ability to control multiple proper-
ties over the span of the tween.

Now, take all of what you know about the “classic” 
tweening method and put it on a shelf for a moment.

Adobe has completely rewritten the animation 
core. The new Motion Model is object-based, not 
frame-based. This is the major difference between 
the 2 methods and it opens up several new doors that 
the older Motion Tween model didn’t allow for. Object-
based tweening enables additional properties to be 
controlled independently while reducing the number 
of steps required with the “classic” tweening method. 
When a Motion Model tween is applied to an object, a 
motion path is automatically generated on the stage. 

flash cs4
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 Using the Bone tool, click and drag from one 
Movie Clip to another, repeating this procedure for 
each additional Movie Clip. 

The very first object in the chain automatically be-
comes the “parent” in the chain. Flash automatically 
creates an “Armature” layer for the chain to reside in. 
Once the chain is complete, use the Selection tool to 
click and drag one of the objects to see the armature 
at work.

With the armature selected, the Properties panel 
is updated to reflect several options. You can enable 
constraints for joint rotation using simple check boxes 
and hot text sliders. This is very useful in situations 
where character animations are rigged with the Bones 
tool. You can specify how far individual limbs can 
rotate based on anatomical accuracies. The Proper-
ties panel also provides “X” and “Y” constraints in the 
same fashion.  Individual custom constraint param-
eters can be set for each individual Bone in the chain.

custom eases. You can apply easing to any or all of the 
properties you wish.

With key modifiers, you can edit the curve of each 
property and then copy and paste curves from one 
property to another. 

Some of you may rarely use the Motion Editor 
depending on your animation needs. As for animators 
using Flash, the Motion Editor may just be the feature 
you have been waiting for. Imagine a workflow where 
you can block out your basic animations on the stage 
using the new object-based Motion Model, and then 
delve deeper into your animation using the new Motion 
Editor. Flash bliss if you ask me.

bones (inverse kinematics)

It’s here! It’s finally here! Remember when you 
were a little kid and Christmas morning couldn’t come 
fast enough? Well the holiday gift-giving just came 
early this year. Inverse Kinematics is now in Flash! 
I have to say, I have been drooling over this feature 
since Macromedia’s MAX conference in New Orleans 
back in 2004. I was there as a speaker and during my 
session showed how I simulated Inverse Kinematic 
by editing the center point of a symbol based on how 
I wanted it to rotate. It was not really close to Inverse 
Kinematics but it sufficed for many years. After my 
session I was approached by a Flash engineer who 
happened to be attending my session. With his laptop 
in hand, he showed me an internal Flash “IK” proto-
type that was very promising. He later sent it to me to 
test and play around with but ultimately the feature 
never made it into Flash for what I can only imagine 
was internal political reasons. 

that Was then, this is noW.

Adobe has appeased the masses by introducing 
Bones, inverse kinematics for Flash CS4. Simply put, 
the Bone tool allows you to quickly link several objects 
together to create a chain-like effect.  It is essentially 
that simple to use too. Duplicate a Movie Clip several 
times on stage and arrange them as you would like. I 
have chosen to create a box car scenario.

flash cs4
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to discover on your own, but at least now you have an 
idea of some of the major enhancements Adobe has 
provided.

Chris Georgeness, is one of the top Flash Animators in the 
business, with an impressive list of clients. He is an author and 
frequent speaker at industry events. He is author of Flash Anima-
tion Secrets (PhotoshopCAFE.com). Chris runs mudbubble.com

An armature can easily be animated but they can 
also be developed for manipulation at runtime in the 
Flash Player. Select the Armature layer in the timeline 
and then use the drop down in the Properties panel to 
change the type from Authortime to Runtime.

3d transformation tools

If all of that wasn’t enough, Flash CS4 supports 
3D transformation and rotation of objects in 3D space! 
Select the 3D Rotation tool from the Toolbar and select 
an object. Here I have imported a bitmap and con-
verted it to a Movie Clip symbol. 

With the object selected, a visually intuitive cross 
hair is displayed, allowing you to manipulate the object 
along its x-, y-, and z-axis. 

The Properties panel provides local and global 
transformation tools for precise control. Field of view 
allows you to numerically define the angle and depth 
of your animation. 

Vanishing point enables you to define the location 
at which your animation disappears in the distance.

Summary

I can easily recall being excited about previous 
releases, but Flash CS4 may prove to be the most 
exciting Flash release to date. There are of course a 
lot more improvements to Flash that you will just have 

flash cs4
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the neW interface

If the welcome screen is not showing, just go to 
Help > Welcome Screen.

multiple artboards - neW

This feature has been long awaited by many Illus-
trator users. Multiple Artboards offers the ability to cre-
ate documents that are multiple pages or double sided 
in a single file. It also offers a way to create single 
documents containing multiple assets of any size. You 
will be able to keep all the art you are creating for one 
job or client in the same file, this will make it so much 

adobe illustrator cs4
Darren (Daz) Winder -www.dawdesign.com

Adobe has done a tremendous job enhancing old 
favorites and introducing long awaited new features 
in the latest upgrade.  I personally am excited to be 
working with the new amazing features, both new and 
enhanced, in Illustrator CS4. What are those features? 
Let’s take a look!

features noW available in illustrator cs4
•	 Gradients  - Enhanced
•	 Appearance of Graphic Style - Enhanced
•	 Multiple Artboards  - New
•	 Blob Brush    - New
•	 Smart Guide   - Enhanced
•	 Live Color   - Enhanced
•	 Clipping Mask              - Enhanced
•	 Isolation Mode  - Enhanced
•	 Type on Path   - Enhanced 
•	 Owl 2.0   - New
•	 Bleed Support  - New
•	 Separations Preview  - New
•	 Color Blindness Preview -  New
•	 Create and Update Unique ID’s for assets  - New
•	 Key Alignment - Enhanced
•	 File I/O   -  Enhancements in Tiff
•	 Graphic Panel - Enhanced
•	 Metrics – Roman Only Kerning -  New
•	 Text Shuffling Performance -  New
•	 UI Cleanup   - New
•	 Creative Suite Services  -  New
•	 Contact Now  - New
•	 Kuler 2.0  - New
•	 Connections  - New
•	 New Sample Art, Tutorials and Libraries  - New
•	

As you can see from this extensive list, this release 
of Adobe Illustrator CS4 really does have something for 
everyone. Long time users, I am sure, will be pleased 
with the accomplished results.

Let’s get started and take a look at what the buzz is 
all about!
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New Document Set Up Showing Number of Artboards

The navigator panel will now show all Artboards 
in a document. Now there is an option to view only 
Artboards or to view the entire canvas.

Control Panel in Artboard Edit Mode

Navigator Panel. 

Ai legacy (CS3 and earlier) and EPS files can now 
be saved as single documents with multiple Artboards 
or can be saved as single Artboards.

Saving Single Documents with Multiple or Single Artboards 

Artboard navigation controls on the status bar of 
the document window are available in all Tool modes.

To access Artboard Edit mode it is available 
through Document Setup dialog with a new Edit Art-
board button.

easier to use common symbols, fonts, colors and track 
changes.

Notice the Tabbed document interface. If you don’t 
like the tab go to Preferences > User Interface and de-
select Open Documents as Tabs. I think this is a good 
idea, but you can’t drag and drop from one document 
to another. You have to copy from one document and 
paste in another document.

Let’s take a look what has gone into this feature.

New Concept of ‘Artboard’ 

This includes multiple Artboards in a single docu-
ment that can be different shapes, sizes and exist 
anywhere on the document canvas, also including 
overlapping each other.

a better user interface for artboards  

This includes a Gray background, soft highlight 
and a darker border on the active Artboard. Check out 
the Artboard Editing Mode and Artboard Tool (this was 
based on the Crop Area Tool taken from CS3). 

Artboard Editing Mode 

A revamp of the print dialog for full control of 
printing documents with multiple Artboards is now 
available in AICS4. The New Document dialog now 
specifies the number of Artboards, their layout, bleed 
around and spacing between them.

The Control panel now offers size and orientation 
as well as the ability to create new Artboards. You 
can also choose whether objects will move with the 
Artboard or not when in Artboard Edit mode.

illustrator cs4



32

illustrator cs4

Multi-page FreeHand files open as multiple Artboards. 
Opening a Legacy Ai file that contains crop areas or 
page tiling. There is now an option to convert the crop 
areas and page tiles to Artboards. Fit all Artboards into 
window (Ctrl+Alt +O) (Cmd+Opt+O) and place Gun 
concept when creating new Artboard.

gradients - enhanced

I am excited about these new features. With the 
enhancements made to Gradients, the new features 
will enable you to work faster, with fewer distractions. 
With a more efficient way to create and edit gradients, 
you can also do things you have never been able to do 
before with gradients.

a quick rundoWn:

When selecting the gradient tool, a gradient an-
notator will appear on all selected objects with gradi-
ents applied. The gradient annotator can be rotated, 
resized and moved. The focal point of the gradient can 
also be adjusted with the annotator. 

You can also turn this off by going to View > Hide 
Gradient annotator (Alt+Ctrl+G) (Opt+Cmd+G)

(Above) Linear Gradient 
Showing Gradient Annotator

(Left) Showing the Gradient 
Annotator Rollover to Reveal 
the Color Stops 

To reset the document rulers to any artboard, click 
on the artboard with any tool, then double click in the 
ruler corner. This will reset the rulers to the current 
board.

You can now create multiple artboards from Device 
Central; File > Device Central. Device Central takes 
multiple Artboard related parameters from the new 
document dialog.

A new item in the select menu allows you to select 
all objects lying in or touching an active Artboard. 

Object > Convert to Artboard - This menu option 
converts the bounding box of selected rectangles to 
Artboards.

Guides created in Artboard tool mode only extend 
across the active Artboard boundry.

Artboard specific rulers can be shown for active 
Artboards through view menu or shortcuts; Artboards 
snap to guides, grids work with smart guides.

and also:

Saving and Exporting of other formats (PSD, JPG, 
TIFF) etc., has been improved. You can specify all or 
specify Artboards to export as these formats. Also the 
ability to create a multi-page PDF file from multiple 
Artboards or specify a page range is now available. 

illustrator cs4



CS4 SuperGuide www.photoshopCAFE.com/cs4  33 

the gradient panel

*  An addition of a reverse button.

* A popup color and swatch panel on gradient  
 stops.

* A new field to edit the opacity of a gradient  
 stop.

* A new field to edit the aspect ratio of a radial  
 gradient making it elliptical.

* Sliders have also been added to most of the  
 controls.

* A new proxy in the panel that allows you to  
 switch between saved gradients, as well as  
 save the gradient you are working on.

blob brush – neW

The Blob Brush?  Yes it is spelled 
correctly. The Blob Brush is a new tool in 
Illustrator CS4. It’s fun and easy to use, 
try it out. Used along side the Eraser and 
Smooth tools, this makes a good addition 
to the set of vector painting tools.

Here are some of the Blob Brush 
features:

Settings can be made in the tool 
option dialog by double clicking on the 

Brush Tool in the Tools panel or use a predefined cal-
ligraphic stroke in the Brushes panel. 

Blob Brush Tool Options

The last used gradient can now fill objects by click-
ing on them with the last used gradient tool. Gradient 
stops can be duplicated, moved and deleted directly 
on the annotator. Curser feedback is available for each 
task. 

Clicking on the end point with the Alt/Opt key will 
allow you to change the angle and length at the same 
time. Create Elliptical gradients by adjusting the radial 
feedback of the gradient annotator. 

Double clicking a gradient stop brings up a popup 
panel where you can edit the stop color. You can also 
edit the opacity of the gradient stop in the popup panel.

Opacity on a Gradient Color Stop

 (L) Save Your Gradient to 
the Swatches Panel from the 
Gradient Panel

(Below) Showing the Angle 
etc. In the Gradient Panel and 
on the Gradient and Annotator

illustrator cs4
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(Left) Recolor Artwork 
Options

 

(Below) Before and 
After Recolor Artwork is 
Applied

The tool creates simple objects or compound paths 
using brush like settings (pressure sensitivity, variable 
widths, angled tips etc.). Creating new objects with the 
Blob Brush automatically merges with other objects 
they overlap if they have the same paint attributes 
without using any external paths or anchor points.

Radial feedback shows the brush size. The brush 
size can be changed using the bracket key. Using the 
Option/Alt key will change to the Smooth tool.

live color – enhancements

Live Color was introduced in CS3. CS4 finishes 
off what CS3 started by making some changes and 
improving usability. The Color Guide looks less like the 
Swatch panel and changed are the default number 

of steps in the 
variation grid. The 
User Interface 
points out the 
current active col-
ors in the varia-
tion grid and also 
shows the current 
settings for the 
variation grid. 
Current color har-
mony rule is now 
highlighted in the 
drop-down list.

Color Guide Panel

illustrator cs4

The Live Color Dialog - 
Context menus have been 
implemented throughout the 
dialog. Drag and Drop colors 
in the current active color 
field and bar view. Set base 
Color Buttons  now makes 
it easy to change the base 
color. Current color harmony 
rule is now highlighted in the 
drop-down list.
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key alignment - enhancements 

Some significant changes have been made to Key 
Alignment. It was always available in Illustrator, but 
now the functionality is more useful.

All Alignment choices are now available in a new 
drop down menu in both the control panel and Align-
ment panel. 

Alignment Choices on the Control Panel

Key objects are easily identified by the thicker edge 
selection. Key objects can be placed by clicking on the 
object a second time after selection, or by choosing 
Align to Key Object found in the new drop down menu.

color blindness previeW

This is a new feature that will be appreciated by 
many designers and individuals with color blindness.

The two new preview modes View > Proof Set, 
Protanopia (no red cones) and Deuteranopia (no 
green cones) show the artwork/design as a color blind 
person would see it.

type on path – enhancements

There have been a lot of comments and problems 
with Type on Path. The New Type on path composer in 
Illustrator CS4 should solve the problems. 

Double click on the Type on a Path Tool in the 
Tools panel for the Type on a Path Options. Here you 
can make changes to the effect of your text. You can 
now align to the center of the path as well as align to 
the baseline, ascender and descender alignments and 
change the spacing of your text.

bleed support – neW

Personally I am pleased to see Bleed Support 
added to Illustrator CS4. Let’s take a look what’s in this 
new feature.

Bleed setting will apply to all Artboards in a docu-
ment. Print and PDF dialogs have also been enhanced 
with Bleed Support, to take document or custom bleed 
values.

Bleeds can be specified in the New Document and 
Document Setup dialogs.

New Document Bleed is Set to 9 pt.

Also a Red Bleed rectangle will show offset from 
the Artboard rectangle, according to the bleed val-
ues. Print Dialog has a Use Document Bleed Settings 
checkbox in the Marks and Bleeds panel.

illustrator cs4
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glyph panel enhanced

Gives better support and preservation of Glyphs 
on copy paste of text across applications, text export/
import, and font change.

Figure-30 Glyphs Panel

separations previeW

This feature includes a User Interface similar to In-
Design and includes separate Color plates and Preview 
results on Artwork. Turn on Overprint Preview directly 
from the panel and also CMYK Meta object that allows 
all CMYK colors to be toggled.

file i/o enhancements in tiff

Tiff import is now live. This means when a Tiff file is 
imported into Ai contents such as pixel layers, vector 
and pixel masks, transparency blends,  spot channels, 
shapes and embedded text will be mapped as closely 
as possible to Ai objects without loss of appearance. 
When importing a Tiff file, there is the option to either 
preserve appearance or preserve editability. Trans-
parency within Tiff files is now preserved. Import of 
Tiff files with different combinations of color modes, 
channel order (Planar and interleaved) and compres-
sions has been improved. Clipping Path in Tiff files will 
be imported live. This is not yet functional, you will see 
this in a future build.

 

appearance and graphic style  
enhancements

The enhancements to these features are a big 
part to improving your workflow in CS4 putting more 
power where you need it, when you need it. Included 
is added functionality to the Appearance pane so you 

create and update unique ids for assets.

Each asset created in Illustrator now has an asset 
ID that will help in doing asset management.

These asset IDs are generated when you save 
a file and are stored as part of the XMP data. You 
can view them in File > File info (Alt+Shift+Ctrl+I) 
(Opt+Shift+Cmd+I) dialog in Raw Data panel or Ad-
vanced panel. The unique ID generation policy is now 
the same throughout the CS4 suite.

text shuffling performance

Text performance has been improved by reducing 
the amount of composition that takes place when text 
is edited. Only the paragraph the text is in will now be 
recomposed when edited. All other paragraphs will be 
moved or ‘shuffled’ to make the change, which will 
result in better performance.

metrics. roman only kerning

This allows users to get auto kerning from the font 
metrics for the Roman text while leaving Japanese text 

unkerned. An option has 
also been added in the 
Kerning drop down list 
in the Character panel to 
turn Roman Only Kern-
ing on.

Metrics-Roman Only Kerning

illustrator cs4
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graphic styles:

To apply a style to a selection without blowing away 
current attributes:

Select an object, then alt/opt click a style in the 
Graphic Styles panel. Alt/opt drag a graphic style from 
the panel and drop it onto an object. Alt/opt drag the 
appearance thumbnail from the Appearance panel 
and drop it onto an object.

 (L)Plain Black Type with the Shirofuchi 3 Type Effect Applied.(R)
Shirofuchi 3 Type Effect with Rainbow Glow Effect

thumbnail enhancements

Thumbnails that render on Type instead of rect-
angles. Visible thumbnails for styles with no paint. 
Preview the style applied to your selected object in a 
large thumbnail by right clicking (Win) or Cmd clicking 
(Mac) on a Graphic style.

Showing the 
Thumbnail Preview 
of the Effect

in other areas:

Select > Same > Appearance allows you to select 
all objects with an appearance equivalent to the cur-
rent selection. A warning icon appears in the control 
panel when the fill/stroke that has focus is not the 
same as the topmost visible fill/stroke in the Appear-
ance panel. Clicking on this icon will give focus to the 
topmost fill.

can edit strokes, fills, and live effects of your selec-
tion in one convenient place. The addition of eyeballs 
also improves your productivity by giving the ability to 
turn off complex effects while editing objects. Graphic 
Styles are far more powerful by adding the ability to 
apply them to objects on top of an object’s existing at-
tributes. Let’s take a look at more of the features:

appearance panel:

Edit Attributes like color, effects and strokes di-
rectly through the panel thanks to new pop up panels 
and dialogs. If multiple selected objects have the same 
attributes these attributes are now editable in the 
panel. ‘Show All Hidden Attributes’ in the Appearance 
panel fly-out menu will turn on the visibility of all hid-
den appearance attributes for the selection. Eyeballs 
to toggle visibility of an effect or appearance attribute 
have been included. New buttons have been added 
to make it easier to add additional strokes and fills to 
your objects.

 

Appearance Panel

 

Click on the Blue 
Underline Wording 
for the Appropriate 
Menu

illustrator cs4
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clipping mask enhancements

Clipping Masks are now improved and easier to 
work with as well as being less of an obstacle when 
working on other objects in the same file.

Here’s what’s changed: When selected only the 
clipping path itself appears selected and objects inside 
the clipping path no longer appear selected. 

(L) Blue Line is the Clipping Mask. (M) Clipping Mask Selected, 

Objects Inside are Not. (R) Clipping Mask Not Selected, Objects 
Inside Are

clipping groups can noW be edited in isola-

tion mode.

Bounding Box of the Clip Group is now the bound-
ing box of the clipping path and not the clipped con-
tent. Transformations (Scaling, Rotation etc.) are done 
with respect to the bounding box of the clipping path, 
but will affect the entire clipping group. The direct 
selection tool will select individual objects (Clipping 
Path or Clipped Object) when you click on any area 
lying on or within the clipping path. Clicks outside the 

smart guide enhancements

Enhancements made to Smart Guides will speed 
up your workflow by helping you move and create 
objects in precisely the place you want them therefore 
eliminating the need to select and align later. They are 
far more useful and less distracting so they are on by 
default. Here’s what’s in this feature:

Smart Guides appear based on the objects edges 
and anchor points, not the mouse down point. 

Alignment Guides now only draw between relevant 
locations, not across the entire canvas. The Alignment 
Guides now appear for all non-hidden objects, includ-
ing stray anchor points. Also, Alignment Guides work 
with the new Artboards, so objects can be aligned with 
respect to Artboard boundaries and center points.

Readouts now appear over anchor and center 
points, disclosing their position. Readouts also appear 
when resizing, rotating and moving objects and updat-
ing live. Readouts also show location information with 
‘SHIFT’ on mouse up. Text now highlights only from its 
baseline unless there is a live effect applied to it. 

The Preference panel for Smart Guides (Edit > 
Preferences > Smart Guides) has been enhanced. You 
can now set Smart Guides color independently from 
the ruler guide color. Also, the default color is now 
green to be consistent with other Adobe applications.

illustrator cs4

 A look at Smart Guides

(L)Smart Guides

(Center)  Smart Guides Now Show the X 
and Y and Angle

(below)  Smart Guides Preferences
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clipping path will have no effect on the Clip Group or 
its content. The Selection tool will select the whole Clip 
Group when you click on any area lying on or within 
the clipping path; clicks outside the clipping path will 
have no effect on the Clip Group or its contents. Smart 
Guides will highlight objects on mouse over only when 
the mouse is within the clipping path’s bounding box. 
Snapping against a Clip Group is now restricted only to 
Clipping Paths inside the Clip Group.

isolation mode – enhancements

Isolation Mode had not reached its full potential. 
Let’s take a look at what isolation mode can do for us 
now:

(L) Isolation Mode, Objects That You Don’t Want to Edit are 
Faded Out. (R) Isolation Mode in Outline Mode

Work in Isolation Mode using more object types, 
gradient mesh, clipping paths, opacity masks, images 
and compound paths. You can also work with a single 
object, isolate top level layers, stay in Isolation Mode 
after deleting an object, now works in outline mode.

Menus and shortcuts now work in Isolation Mode 

Lock Selection, Hide Selection, Show All, Unlock 
All. Use the Escape key to exit Isolation Mode.

Clipping Group in 
Isolation Mode

creative suite services
Darren (Daz) Winder 

oWl 2.0

As you know, this is a suite feature and not an 
Illustrator specific feature. Here are the key features 
that have gone into ‘OWL’:

application bar

Application Frame (this will now be off by default on Mac).

spring loaded panels

other features

Flotillas

N-up View

Document Groups and tabbed documents

Tabbed Documents

Arrange Submenu under Windows menu

Workspace Switcher in the Application Bar

search for help

Search for help does not only make it easier to get 
help by providing a search field in the Application bar 
but it also gives more choices as to what type of help 
you want. It gives access to information and tutorials 
from your peers and the Illustrator community at large. 
Test it out by typing in a term, and see how much 
information you have instant access to. Try more, this 
is not static information as all of these links are from a 
live ranked web search. You might find yourself getting 
carried away with the wealth of information.

illustrator cs4
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connections

Connections is a one-stop panel for authentication 
and management of all the great new Suite Features. 
It contains an option off the fly-out menu to set these 
services to offline; find it under Window > Extension > 
Connections.

kuler 2.0

Many of you are familiar with Kuler from CS3 
although it was hidden under the Adobe Labs menu. 
If you haven’t tried Kuler 2.0 now’s your chance! You 
can find it under Window > Extensions > Kuler.

neW sample art, tutorials and libraries.

Check it out in the Cool Extra’s Folder (for sample 
art), and from the library button on the relevant panel 
libraries.  You’ll find updated template files, how to 
take advantage of the powerful new Multiple Art-
board feature, 9 new sample art files, 6 new Tutorial/
Walkthroughs, several new Brush, Gradient, Symbol, 
and Graphic Style libraries as well as new Document 
Startup Profiles.

Darren A. Winder (Daz), graphic designer, web designer, teacher, 
technical editor of books on Photoshop, Illustrator and PainterX.
He can be found at PhotoshopCafe.com answering questions on 
Illustrator and Photoshop. www.dawdesign.com

illustrator cs4

connectnoW

Are there time that you wish you could be sitting in 
the same room staring at the same computer as you 
discuss details and ideas with someone? Adobe Con-
nectNow won’t put you in the same room, but it will 
give you the next best thing! ConnectNow allows you to 
share your screen with up to 2 other users, for FREE! 
It is also available as a paid service, which will allow 
you to connect with more people. Try it out. You will 
find it under File > Share My Screen.

(L) Connect Now 
Sign In Screen

(Middle) Enter 
Meeting Sign In 
as a Guest or Use 
Your Adobe ID

(Bottom) Connect 
Now Meeting 
Room.
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don’t add a perception of bloat on the other. I can’t tell 
you how many times in the past I thought, “Boy, I sure 
wish this program could do so and so…” and then 
bam, the next version of the software can do it! Let’s 
take a quick tour of the program to see what cool new 
things Adobe added to Dreamweaver.

neW user interface

One of the first things you’ll notice in CS4 are the 
changes to the interface. Changing the way a program 
looks or operates is always problematic; it’s guaran-
teed that if the changes are major you will anger users, 
but if the changes are merely cosmetic, people will 
wonder why they are paying for the upgrade in the 
first place. For CS4, you’d have to look carefully to find 
some of the changes, but you’ll find most of them wel-
come additions. For example, Windows users will im-
mediately notice that the Title bar is missing. Although 
it sounds like an insignificant alteration, it means you 
now have an extra 50 pixels of screen real estate for 
your workspace. 

dreamWeaver cs4
By James J. Maivald- www.DesktopDesign.cc

Each time I take a look at an upgrade it is always 
with mixed feelings. First, there is the anticipation of 
Christmas morning, what new cool features will I find 
under the tree…er, menu structure…and what great 
new things will the program enable me to do now. 
Then, there is always a little fear or anxiety, usually 
centered around wondering whether any of my es-
sential features—ones I use everyday—have been 
changed to the point that they are unusable or, worse 
yet, have been removed from the program altogether! 

Finally, there’s the angst we all encounter once 
you’ve seen the changes about whether it’s worth the 
price to upgrade to the new version. 

All in all, I think the outlook for Dreamweaver CS4 
is a positive one overall. I don’t know how Adobe does 
it, but somehow they find features and tools to add to 
their programs that are really useful on one hand, yet 

Although the changes are more than 
cosmetic, they may be easy to find 
for those unfamiliar with the pro-
gram. Here’s a quick key to the new 
features: 1. Title bar eliminated. 2. 
Workspace manager. 3. Related files 
interface. 4. Live View and Live Code. 
5. New Insert Panel. 6. Vertical Code/
Design Split. 7. Code Navigator.
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The new Insert panel sports a few more buttons and 
one new category, but that’s not the reason for the 
move. The new location was necessitated more by 
the addition of the new Related File buttons, which 
are described below. The vertical display of the insert 
buttons now provides the room for description words 
to accompany the sometimes cryptic icons. But the 
new panel takes up a lot more space and will be less 
popular than other changes in the program. Luckily, 
Dreamweaver offers a “Classic” workspace option that 
relocates the Insert bar to its former home.

vertical code split

One of the handy features in Dreamweaver just got 
handier. The Split view allows you to view the HTML 
code at the same time as the design. Before, the two 
windows only split horizontally. CS4 now allows you to 
split the Code and Design views vertically, too. Al-
though it seems a small thing, the feature actually got 
an ovation when I showed it to a group of Webmasters 
in August. 

Split view now offers a vertical option, which has been a sure 
crowd pleaser.

related files and code navigator

A new feature in CS4 that will be greeted with 
enthusiasm by many Web designers is the Related 
Files interface. It will dramatically change the way 
you will work with Web pages from now on and will 
be one of the “must-have” features for most upgrad-
ers. The concept is a simple one but far reaching. 
Whenever you open a Web page that relates to other 
components—like XML data, a cascading style sheet 
or JavaScript file—the related files are displayed as 
clickable buttons above the document window. If you 

Workspace manager

The last few versions of Photoshop and InDesign, 
and the last couple versions of Illustrator, have all 
allowed users to create and save their workspaces. It 
was a great way to set up the programs for a specific 
function and then quickly reset them for other tasks. 
I use it a lot in Photoshop to switch between print 
(CMYK) and web design (RGB) workflows. Now, the 
ability to create, save and recall different workspaces 
has been beefed up in Dreamweaver and moved out 
of the Window menu. It’s now taking up prominent 
residence right on the main menu bar (application 
bar) in its own pull-down menu. You can choose from 
one of the eight default settings or create and save 
your own right in the menu.

insert bar

Another change has moved the Insert bar from its 
familiar home above the CODE/SPLIT/DESIGN buttons 
to the panel dock on the right side of the program. 

dreamWeaver cs4

Like Photoshop, 
InDesign and Illustra-
tor, Dreamweaver 
features a more 
robust workspace 
manager that allows 
you to create, save 
and access different 
workspaces, quickly 
and easily.

The Insert bar is now a panel. It 
was moved to make room for the 
Related Files interface, but now 
it takes up gobs more space than 
before. You can save some room 
by hiding the labels (shown above) 
or select the Classic workspace to 
return it to its original location.
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the document window. It’s not perfect and doesn’t 
eliminate the need for testing your pages in the brows-
er altogether, but it’s a great start. Simply click the Live 
View button and the document window renders the 
CSS and dynamic content as if it’s in a browser—your 
CSS-based roll-overs will operate, videos will play and 
database driven elements should operate properly. To 
return to normal, just click the Live View button again 
to toggle the display.

Along side Live View is another new feature called 
Live Code. Whenever Live View is activated, the Live 
Code option is available for selection. Press the button 
and a code window appears showing you the actual 
code updated with live data, which permits you to see 
how the actual data is structured and formatted in the 
layout. Together, Live View and Live Code will eliminate 
hours of time wasted loading and testing pages in your 
browser.

ajax and javascript code hinting

Many hand coders have resisted using Dream-
weaver for reasons that I have never understood. 

want to check the data, modify a style rule or edit a 
script function, just click the file name and it will ap-
pear in the document window, fully editable. No more 
will you have to hunt down the files associated with a 
particular page and go through the hassle of opening 
each to edit them. Basically, each of the related files is 
just a click away.

Open any file and Dreamweaver displays all the files related or 
linked to its content above the document window. Click on any 
of the file names and the contents will be displayed in the docu-
ment window.

Working hand in hand with related files is the new 
Code Navigator. This revolutionary feature instantly 
analyzes each code element in the file and automati-
cally maps the relationships between it and specific 
CSS rules or other files that affect it. Code Navigator 
will be an indispensible tool for every designer en-
abling you to troubleshoot problem code in seconds 
instead of minutes or hours (or never). To access the 
Code Navigator just insert your cursor in any piece of 
code, right click and select Code Navigator from the 
context menu. You can also activate the feature by 
Alt-clicking on a specific element or by choosing the 
option from the View menu. Adobe realized that this 
would be a popular feature, so it sprinkled the Code 
Navigator icon around the interface so you don’t have 
to go very far to find it.

live vieW and live code

Although Dreamweaver is considered a WYSIWYG 
Web design program, the program’s Design view has 
always left something to be desired, especially when 
viewing dynamic elements and certain types of format-
ting. Basically, these elements just didn’t display prop-
erly. The only way to check these items was to preview 
them in a browser, which wastes precious time in the 
work day. Live View is a new feature that promises to 
recoup this wasted time by allowing you to preview 
most CSS formatting and dynamic elements—Flash 
animations and Spry widgets, among others—live in 

Live View will save hours of browser-based testing. Click the 
button and CSS-based formatting and dynamic elements will be 
rendered as they would in a true browser.
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the Smart Object in your Web page to maintain the 
most up-to-date content. It also allows you to continu-
ally adjust the size of the image without worrying about 
the loss of quality. 

Using a Smart Object is no different than inserting 
any other type of image. Select Insert>Image, choose 
a PSD from the file structure (it doesn’t have to be 
within the Web site hierarchy) and click OK. Dream-
weaver will open the PSD in the Image Preview dialog, 
where you can adjust its format, dimensions and even 
crop it. When you click OK, Dreamweaver saves the 
optimized version of the image in your site, while the 
original PSD is not affected. That’s a big help all by 
itself, but that’s not all. The real advantage to Smart 
Objects comes when you want to modify the image: 
Smart Objects allow you to change their dimensions, 
up or down, adjust the cropping or even remove it 
altogether, and when you click OK the JPEG or GIF will 
be updated and replaced in the layout!   

There are so many productivity features that enhance 
the hand-coding experience; it seems to be a no brain-
er to want to use the program. Code Hinting is one of 
those features. It’s not a new feature, it’s been around 
forever, but it has now been enhanced to include 
support for JavaScript frameworks, including jQuery, 
Prototype and Adobe Spry. The way it works is simple. 
Whenever you work in Code view as soon as you 
type an open bracket “<” Dreamweaver kicks in and 
provides a list of legal code elements in the form of a 
drop-down menu. Select the element you want and 
the program continues to provide you sub-elements, 
attributes, or functions that support the first choice. 
Code hinting also provides assistance in nesting ele-
ments properly. Type “</” and Dreamweaver will close 
open elements in the appropriate order. In addition to 
Dreamweaver’s ability to manage site-wide files and 
links, built-in FTP support and synchronization, Live 
View and Live Code, the added support for JavaScript 
code hinting is making Dreamweaver an environment 
that is harder and harder to resist for hand coders.

adobe photoshop smart objects

The release of CS3 introduced Dreamweaver 
users to tighter integration between the other Adobe 
products. It meant that you could use native PSD files 
directly in your Web layouts, and Dreamweaver would 
take care of the image optimization and saving of the 
file in GIF, JPG or PNG formats. CS4 ups the ante by 
allowing you to insert PSD images as Smart Objects. 
As you probably know, Smart Objects was introduced 
in CS2 and allows you to work with images in one 
application or workflow, while maintaining a live con-
nection to the original image. That way, whenever a 
change is made to the original image, you can update 

dreamWeaver cs4

Code hinting has been improved to support Javascript and Spry 
frameworks. Type an opening bracket and Dreamweaver provides 
a drop-down list of legal elements, attributes and functions.

Insert any PSD as a Smart Object in Dreamweaver to maintain a 
live connection to the original image. The icon visible at the up-
per left corner of the image means you can change the size, for-
mat and even cropping without adversely affecting image quality.
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improved css support

Dreamweaver was one of the first HTML editors 
that fully adopted CSS formatting and each new ver-
sion of the program has improved this support. CS4 
is no exception. As the Code Navigator, Live View, 
Live Code and Related Files has improved the view 
and analysis of CSS code formatting, Dreamweaver 
has also improved the way you create CSS in the 
first place. A new option has been added to the New 
CSS Rule dialog called Compound. This formalizes 

what has been a feature of Dreamweaver for several 
versions, where the program automatically constructs 
compound CSS rules based on context. Two buttons 
have been added to the dialog to speed up the pro-
cess by quickly editing the compound to make it more 
or less specific. The dialog also provides clearer de-
scriptions of how the specific rule fits in the cascade.

CSS-based changes were made to the Property 
Inspector, too. Take a look and you will see HTML 
and CSS buttons that allow you to access appropriate 
formatting for each element within the layout. Rules 
can now be created, applied and edited directly from 
the Property Inspector. 

html data sets

There is no HTML editor that I am aware of that al-
lows you to create data-driven dynamic layouts easier 
than Dreamweaver. The UltraDev extension was incor-
porated into the program back in version 4 and Ado-
be’s Spry framework in CS3. But no matter how easy 
it is, there will be those for whom it is still too esoteric. 
CS4 provides the solution. Along with ASP, ColdFu-
sion, PHP and XML, Dreamweaver now can use HTML 
tables as data sets, too. Gone is the learning curve for 

dreamWeaver cs4 dreamWeaver cs4

Changes to the 
New CSS Rule 
dialog only scratch 
the surface of the 
improvements to 
CSS features in CS4.

 
1. Select a page containing an HTML table and create a Spry 
Data Set.

2. Select an Insert option and apply the desired CSS formatting.

3. Click Done.

using html tables as a dynamic data source is 

as easy as one, tWo, three. 
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page that can be accessed through an online service, 
where the content can be added or modified right in 
the browser, without the need of any special software 
or training. The service was not available for testing as 
of the date of this writing, but it looks like InContext 
Editing will be a highly useful service.

subversion integration

As InContent Editing promises to improve the 
coordination of clients and contributors, the integration 
of Subversion promises to improve the interaction with 
co-workers, too. An open-source versioning control 
system that’s been around since 2000, Subversion of-
fers more robust management of online resources and 
powerful check-in/check-out features. The service was 
not available for testing as of the date of this writing.

mia (features missing in application)

As in most upgrades, some old features don’t 
make the cut. The following features have been re-
moved from CS4 due to the lack of user interest and 
cost in maintaining:

ASP.NET and JSP server behaviors and recordsets

Flash buttons, elements (Image Viewer), and text 

Java Bean support

Layout mode

Site Map view

Timelines

Web services

conclusions

After using the various beta versions of CS4 for the 
last few months, I can only say that it would be hard 
if not impossible to go back to a previous version. I 
have found innumerous uses for the Code Navigator, 
Compound CSS rule and Live View. I’m sure you’ll feel 
the same way.

James Maivald is a designer, consultant and Adobe Certified 
Expert and Instructor with over 25 years of experience in the 
graphic design industry. He is also an author of hundreds of 
magazine articles on graphic design and electronic publishing, 
as well as several books. He has an upcoming video on Dream-
weaver (photoshopCAFE.com). www.DesktopDesign.cc

database design and 
development; gone 
is the arcane discus-
sion of tag names 
and data structures. 
Now you can simply 
put the data you want 
in an HTML table 
and then connect 
multiple pages to it to 
drive your dynamic 
content. 

Using an HTML 
data set can’t be 
any easier. Simply 
create a table and fill 
it with data—names, 
addresses, phone numbers, etc. Create and assign a 
unique id for the table and save the file in your site. 
Then, create a Spry Data Set. When the Spry Data Set 
dialog opens, choose HTML from the Select Data Type 
pull-down menu. A nice aspect of using HTML data 
sets is that you can save multiple tables in one file and 
access each independently. Once created, you can 
use an HTML data set almost identically as you use an 
XML-based data set. If nothing else, HTML data sets 
allow you to quickly display the same data in multiple 
ways. For example, show a list of contacts ordered by 
last name, then by company, and then by title. Never 
again will table data be considered locked away and 
dead. 

incontext editing

Working with contributors or clients has always 
been difficult on the Web. How do you control access 
and versioning across an entire site and yet allow 
multiple users to contribute content? Previously, con-
tributors had to purchase a full copy of Dreamweaver 
or Contribute to access the Web site. Besides the cost 
of the software this also required time and money to 
learn how to use it. In CS4, Dreamweaver has imple-
mented a feature called InContext Editing that promis-
es to simplify this process. InContext Editing allows you 
to insert Editable and Repeating regions in the Web 

dreamWeaver cs4

A nice aspect of 
using HTML data 

sets is that you can 
save multiple tables 
in one file and ac-
cess each indepen-
dently. Once cre-
ated, you can use 
an HTML data set 
almost identically 

as you use an XML-
based data set. 
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really liking the new darker-gray interface and CS3 
already feels quaint and old-fashioned. Our favorite 
new UI feature is the ability to have more than one file 
open within a single document window (each with a 
different tab, a la Web browsers).

We also love the new panel features, especially 
being able to make floating “docklets” that contain 
multiple panels and put them anywhere we want on 
screen.

text features

We’re “text heads” so we have to admit our ten-
dency to like all things relating to text-and-type. In this 
department, InDesign CS4 rocks. For example:

Conditional text. You 
can create one or more 
conditions and then 
apply them to any text 
you want. For example, 
let’s say you’re creating a 
brochure that will ap-
pear in both the USA and 

Australia. You could make a condition in the Condi-
tional Text panel called “English English” and apply it 
to the “u” in “colour” and “harbour”. When you want 
to print the US version, turn off the condition (click the 
visibility icon in the panel) and the “u” disappears. In 
fact, text can have more than one condition applied to 
it simultaneously, opening up all sorts of possibilities 
for single-source, multi-channel publishing.

Cross-references. This is the holy grail for many long-
document publishers: The ability to create sentences 
such as “See Figure 5-4 on page 19” and then have 
those cross-references (x-refs) update automatically 

What’s neW in indesign cs4
David Blatner and Anne-Marie Concepción - InDesignSecrets.com

It takes 24 hours for the Earth to revolve around 
the sun, 12 months to orbit the sun, and—just as 
surely—about 18 months for Adobe to release a new 
version of the Creative Suite. So as the sun rises on a 
new day, Adobe today an-nounces Creative Suite 4, 
and with it, a brand new version of InDesign.

InDesign CS4 is chock full o’ cool new features, 
but ultimately this upgrade is evolutionary, not revolu-
tionary. It’s heartening to see that Adobe has been lis-
tening to its users and added long-requested features 
such as cross-references and real pre-flighting to the 
industry standard page layout program. But if you’re 
looking for groundbreaking new functionality that will 
improve every InDesign user’s worklife, the pickin’s are 
on the slim side.

Let’s take a quick look at what you’ll find in InDe-
sign CS4. Note that this overview only gives a glimpse 
of what’s to come; you’ll find far more detail in David’s 
upcoming article in InDesign Magazine (Issue 26) and 
in future blog post-ings at InDesignSecrets.com.

interface

While we initially complained bitterly about yet-
another-user-interface-change, after some months of 
using beta ver-sions of CS4, we now find ourselves 
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interactive features

Adobe started showing off some “future technology 
demos” at the beginning of 2008, in which they could 
export SWF files directly out of InDesign, or export 
something called an XFL file that could be opened in 
Flash. For legal and financial reasons they couldn’t say 
whether these features would be in CS4, but today we 
can yell a big “Yes They Are!”

While it’s cool to be able to export SWF directly 
from InDesign, Adobe hasn’t given us many interac-
tive features to work with. For example, you can make 
buttons, hyperlinks, and page transitions that survive 
the export to SWF — in fact, InDesign CS4 has brand 
new Buttons, Hyperlinks, and Page Transitions panels. 
However, imported movies and sounds are stripped 
away. Sure, you can import a SWF file into InDesign, 
but it won’t show up in an exported SWF file. Why 
can’t Adobe just grab the Quark Interactive Designer 
panel and put it in InDesign? Because they want you 
to use XFL and open the file in Flash, of course.

The good news is that Flash CS4 is way, way, 
way better than any previous version. That is to say, 
it works more like an 
Adobe application, and 
there are a number of 
cool things you can do 
even if you don’t know 
ActionScript. (The bad 
news is that hyperlinks, 
page transitions, but-
tons, and pretty much 
everything interactive 
drops out when you ex-
port to XFL … because 
the idea is to design 
in InDesign, and add 
interactivity in Flash.) 
However, the beautiful 
formatting you applied 
to text in InDesign is 
maintained–and fully 
editable–in the Flash 
file.

when the figure or page number changes. Now it’s 
amazingly simple in InDesign CS4. Why Adobe hid the 
cross-references feature inside the Hyperlinks panel is 
a mystery, but that’s where you’ll find it.

Line styles. Ever since we started using nested 
styles a few years ago we’ve wanted to apply a charac-
ter style to the first line in a paragraph — not just the 
first few words, but the whole line. Now you can do 
this, with the new line styles fea-ture. It’s separate from 
nested styles (though in the same dialog box), but it 
works pretty much the same way. Since they’re separate 
controls, you can combine “regular” nested styles with 
nested line styles (and even GREP styles — see below) 
in the same paragraph or even instance of text.

GREP Styles. If you’ve ever played with GREP in 
the Find/Change dialog box, you know that it’s incredi-
bly powerful. However, the problem is that you need to 
run a find/change routine each time you want to make 
a change. GREP Styles changes all that: It’s a way to 
attach a GREP find/change routine to a paragraph 
(or better, a paragraph style). For example, within the 
Body paragraph style, you could configure the GREP 
style panel to format all the text inside parentheses 
with an italic character style. If a story contains 10 dif-
ferent instances of parenthetical remarks, they all get 
converted automatically as soon as you apply the Body 
style to the paragraphs. It’s amazing.

Smart Text Reflow. InDesign users have complained 
(with good reason) for years about InDesign’s inability to 
auto-matically add pages and text frames as you type, 
paste, or edit text. After all, QuarkXPress has done this 
for two dec-ades. Fortunately, InDesign CS4’s Smart Text 

Reflow lets you do this. 
Plus, as you’d expect, 
it’s actually even more 
powerful than XPress’s 
feature. For example, 
you can also set it up 
to automaticaly delete 
extra blank pages when 
you remove text. Again, 
long-doc folks will eat 
this up.

indesign cs4
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InDesign what you want it to look for. For ex-ample, you 
could have it search for overset text frames, images 
that are below 150 ppi effective resolution, graphics or 
text that have been scaled disproportionally, and page 
objects that don’t bleed far enough off the side of the 
page.

Even better, it does all this checking in the back-
ground while you work, even if the Preflight panel is 
closed. (In-Design displays a little green light in the 
document window when there are no errors, or a red 
light when it finds one.)

but Wait, there’s more!

We just don’t have space to cover all the features 
in this short overview, but we would be remiss in our 
duty if we didn’t at least mention a few others that 
we’re so happy to see in this version.

Rotate Spreads. You can rotate one or more 
spreads of a document by 90- or 180-degrees. Very 
useful for making cal-endars or viewing rotated text!

Power Zoom. The Navigator panel has been re-
moved and replaced with the Power Zoom mode. Get 
the Hand tool (hold down Option/Alt-spacebar) and 
hold down the mouse button for a moment and InDe-
sign zooms back to show you the whole spread, along 
with a red navigation rectangle. Drag that rectangle 

If you still prefer PDF to Flash, that’s okay, too. All 
those page transitions and buttons and hyperlinks (and 
even movies and sounds) can be exported to interactive 
PDF files

linked images

InDesign CS4 offers a few cool features for those 
of us who place a lot of images. First, the Links panel 
has been given a ground-up workover, and it’s just so 
much better. We didn’t really think the old Links panel 
was so bad, but now that we’re used the new fea-
tures — such as choosing which information we want 
to display, an interactive File Info area, arrangeable 
columns like a spreadsheet or database — we just no 
longer want to go back.

Two other link-related features bear mentioning, as 
well: There’s (finally) an “Edit With” feature that lets 
you choose which program you want to launch to open 
a file. And the Place cursor (the thing you get when 
you choose File > Place) has some hidden features 
now. For example, as you click-and-drag, InDesign 
constrains the size to the propor-tions of the image 
you’re placing. Small but sweet!

Also, if you’re placing more than one image at a 
time, and you hold down the Command-Shift/Ctrl-Shift 
keys while dragging, the images get placed into a grid 
on the page. It’s a handy and fast way to make a con-
tact sheet out of a bunch of graphics.

preflighting

One of the most important new features in InDe-
sign CS4 is the Preflight panel. Adobe ripped out the 
not-very-useful Preflight feature from earlier versions 

and replaced it 
with a grrrrreat 
way to check 
(and double-
check) your 
docu-ments. 
Most impor-
tantly, you can 
create cus-
tom preflight 
profiles to tell 

indesign cs4 indesign cs4



CS4 SuperGuide www.photoshopCAFE.com/cs4  51 

someplace else and let go of the mouse button and 
you zoom right back in on that new location.

Smart Guides. Taking a cue from Illustrator, 
InDesign CS4 now has smart guides that show up 
whenever you create, drag, or resize an object. For 
example, you can drag one frame below another and 
quickly align it to the left, center, or right side of the 
frame above it based on the smart guides that ap-
pear. Or, you can drag one frame between two others 
until the smart distribution guides indicate that there 
is equal space among all three objects. Very smooth, 
very power-ful.

Tables in Story Editor. Our list of features wouldn’t 
be complete without mentioning a feature that we 
(and many others) have been craving for years: Seeing 
table data inside the Story Editor window. The problem 
is that Adobe blew their whole “nice UI” budget on the 
general interface and gave the challenge of coming up 
with a clever way to show tabular data inside Story Edi-
tor to an intern who hadn’t actually ever used InDesign 
before. At least that’s what it looks like to us. Oh well, 
maybe they’ll make it prettier in CS5.

Speaking of CS5, hang on to your hats… If the sun 
keeps shinin’, the Earth keeps spinnin’, and Adobe 
sharehold-ers keep expectin’, then we’re putting our 
money on the Summer of 2010. In the meantime, 
however, we have a lot of exploring to do in this new, 
and very welcome upgrade.

David Blatner and Anne-Marie Concepción are regarded as the 
top InDesign experts and have authored a ton of book and spo-
ken at many events. Together they run the top InDesign Resource 
and magazine InDesignSecrets.com

indesign cs4
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panels, hide others and get everything just the way 
you wanted it, so you would save that setting? Well in 
Fireworks CS4 you will now notice a dropdown box on 
the right side of the application (when the app frame is 
visible) where you can quickly switch workspaces.

Here is a comparison of the 2 options, choose 
whichever ones works better in your workflow.

Fireworks CS4 with the app frame and without

text engine improvements

One of the best improvements to Fireworks CS4 
can be found in the text engine. However, you may not 
notice any difference at first glance, because the true 
improvement is under the hood. 

Fireworks CS4 now has the same text engine that 
is found in Adobe Photoshop. This means a much bet-
ter text engine for all. 

You may be asking yourself, what does a better text 
engine offer? Well, simply put better performance in 
rendering and editing, which of course can translate 
into less design time and faster changes.

Performance is not the only improvement to the 

fireWorks cs4
By Matthew Keefe - mkeefeDesign.com

Fireworks CS4 gives you the ability to rapidly 
prototype websites, mobile interfaces, application UI’s 
and interactive designs with ease.

Fireworks CS4 introduces a very impressive list of 
new features and abilities. 

The list includes:
•	  - New User Interface
•	  - Text Engine Improvements
•	  - Style Improvements
•	  - Tooltips
•	  - Live Gradients, Patterns, and Masks
•	  - CSS/Images Exporting
•	  - Exporting to PDF
•	  - Performance
•	  - Asynchronous Saving

 

neW user interface

The most obvious update found in Fireworks CS4 
would have to be the new application interface. Fire-
works does sport the new “CS4 look” that the other 
apps in the suite have. However, for a user of previ-
ous versions it may be a bit of a shock. Overall the 
new UI is more streamlined and contained.

The Mac version is especially different because 
of the “App Frame”, which gives you the ability to 
re-locate the panels and other application elements 
into one neat package, instead of the “classic” float-
ing panels of CS3 and before. Adobe does give you 
the ability to work in the old way with the floating 
panels, by simply disabling the app frame “Window 
> App Frame”. By default Fireworks open with the 
app frame disabled, but can easily be enabled by the 
previous mentioned step.

One preference that was always buried was 
custom workspaces. You know when you would move 
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Saving indicator at the bottom of a document

When you save a file in Fireworks CS4 you will no-
tice a little progress bar will appear towards the bottom 
of the documents frame. This is a visual indicator that 
the file is currently being saved. The amazing thing 
about this new saving ability is the lack of performance 
decline while saving a file. You would assume a pro-
cess such as saving to be a big performance killer, but 
in this case, it’s not. 

speed...speed...speed!

Fireworks CS4 comes with amazing speed increas-
es. In CS3 you would find the application to become 
sluggish after extended use. This was due to various 
memory leaks within the core of the application. These 
have been taken care of in Fireworks CS4 and overall 
the application is more responsive. 

Another aspect of performance that has been 
updated is loading files. You will also see more re-
sponsive documents in CS4 due to these memory and 
performance updates. You will only see an improve-
ment in CS4 documents due to the way it is handled. 
In order for you to see the increase in speed in a CS3 
document, you must first re-save the document in 
Fireworks CS4.

style improvements

Designers now have the ability to create style sets 
in Fireworks CS4. These style sets can be linked to 
other objects and shapes throughout your documents. 
When you make a change to the master style, all the 
others will be changed, meaning less time needed to 
make minor style tweaks.

The various style options are found in the Property 
Inspector (PI). The PI is also where you will find many 
tools to quickly redefine styles, as well as break style 
links, delete styles or override master styles.

Adobe has also packed the style panel with some 
great default styles. They hired various designers to 
create some pretty interesting styles that you can 
quickly use in your prototyping projects. The style 
dropdown box offers many style sets that can be 
loaded which offers many themes and options.

text engine, when it began sharing the Photoshop 
engine it also got the ability to have font styles and 
support for ligatures. The integration ability is also 
enhanced because your text will look similar going 
from Photoshop to Fireworks which means less modi-
fications required when in Fireworks, but also a more 
consistent look overall.

Text panel in CS4

TIP - You can even place text within a closed path and 
the text will reflow properly which can create some 
very interesting and unique layouts.

tooltips

You will find the use of tooltips in many aspects of 
Fireworks CS4. One place this really turns out to be 
useful is when positioning objects on the canvas. 

Tooltips are not turned on by default, but can 
manually be enabled by going to “View > Tooltips”. 
Now when you begin to drag your mouse around you 
will notice the X and Y position is readily viewable in 
the tooltip just below the mouse cursor

TIP - You can enable tooltips using the keyboard 
shortcut ( CMD/CTRL + ] )

Tooltip below the mouse cursor, showing x and y position rela-
tive to the document  

asynchronous saving

A common issue with application is the time it 
takes to save a file. Fireworks CS4 introduces asyn-
chronous saving, which basically means the file is 
saved while you’re working. The advantage to this 
approach is the ability to work on a file, save it and 
immediately move to another file while the first file is 
being saved.

fireWorks cs4
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If you happen to use non-standard font styles in 
your design, Fireworks will warn you with an alert box 
when you attempt to export. This offers you the sug-
gestions of exporting the text as images (if it’s static) or 
choosing a “web friendly” font family.

live gradients, patterns and masks

Often times you find yourself editing gradient op-
tions to get the perfect result, but constantly changing 
options, applying them and reviewing the result can be 
time consuming. New to Fireworks CS4 is that you can 
now work with Live Gradients. As you make changes, 
the gradient on the canvas automatically reflects those 
changes, allowing you to quickly make changes and 
move on to the next task.

This Live ability is also found on the Patterns and 
Masks, truly offering the ability of rapid prototyping to 
Fireworks CS4. Once you start using it you will wonder 
how you lived without it.

Wrap up

You should now have a pretty good understanding 
of the new features in Fireworks CS4. Now you can 
start rapidly prototyping your designs with ease and 
much better performance.

One last thing to note, unlike the other applica-
tions in the CS4 suite, you can actually download a 
beta version of Fireworks on the Adobe labs. This will 
not be the exact version that will be found in the suite 
once it’s released, but it can cure your desire to use 
Fireworks CS4!

Matthew is a new-media designer, developer, author and trainer 
who recently wrote the Flash and PHP Bible. He is also Technical 
Editor of a number of books. www.Scriptplayground.com

exporting to pdf

When a designer needs to present a design to a 
client they often create a complete web page where 
the user can “click around” and really understand 
how the site will come together. The problem with 
this approach is that it’s both time consuming for the 
designer and risky because the client gets everything 
they need to use the site, automatically.

In Fireworks CS4 you now have the ability to create 
a fully clickable PDF that you can send to your clients. 
This means they don’t get a complete site to run with, 
but do get the overall functionality of a web site. You 
can also make use of the commenting feature in PDF 
and allow them to directly comment, which is a wel-
come update from the “old school” email methods.

adobe kuler

Adobe Kuler is a web site 
where users can create color 
sets, save them and share 
them with other users. Fire-
works CS4 has a Kuler panel 
that allows you to quickly 
search for colors and apply 
them to your design without 
ever leaving Fireworks. You 
will actually find this panel 
in many of the CS4 applica-
tions included in the suite.

css/images exporting

You now know Fireworks CS4 can export a PDF, 
but what happens if you want to create a complete site 
from your design? Simple, export it as a CSS/HTML 
package. In Fireworks CS4 you can export standards 
compliant HTML and CSS directly from a PNG (Fire-
works document). Fireworks will even properly convert 
rich symbols to their HTML equivalent. For instance, if 
you define a shape as a button, Fireworks will cre-
ate the <button> code directly in your exported file 
automatically.

fireWorks cs4
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• Improved integration with other Adobe products 

• Enhanced editing efficiency 

• Direct-to-disk recording with cross-platform,   
 redesigned Adobe OnLocation CS4 

• Project intelligence with new XMP metadata support 

• Speech Search makes dialogue in your video   
 assets searchable 

• Blu-ray Disc output 

• Web-versions of your DVD and Blu-ray Disc projects  
 made easy with Adobe Encore CS4 

• Creative Pro Online Services 

Let’s take a look at each one individually.

tapeless camera support

Capturing video directly to disk have been talked 
about for awhile and the benefits of time-savings as 
well as the ability to keep the highest level of quality 
throughout a production have had us all salivating for 
some time. Well that wait is over as Premiere Pro CS4 
is ready to allow you to get the most out of tapeless 
workflow.  This alone will eliminate the time-consum-
ing process of capturing our footage from tape saving 
us time and valuable resources.

Premiere Pro now has a wide range of video format 
support that includes DV to HD and more. There is 
also full support for a variety of tapeless cameras and 
media allowing you to go from capture to edit faster 
than ever before while retaining the high level of qual-
ity from your source material. 

What cameras can you import from? The Pana-
sonic P2 cameras in DVCPRO, DVC DVCPROHD, and 
AVC-Intra formats and across multiple P2 cards all 
allow you to import and natively edit content. In about 
the same way, you can import and edit content from 
Sony XDCAM EX and XDCAM HD cameras directly, 
without rewrapping or transcoding.  Here is a cool fea-

premiere pro cs4 
by Bruce Bicknell

The folks at Adobe have been listening to the us-
ers and have incorporated a ton of new features into 
the new Premiere Pro CS4 application. When you 
open Premiere Pro CS4 for the first time there will be 
a different but familiar look to the interface. What I 
mean by this is that Adobe has given Premiere Pro 
CS4 a fresh look to the interface. The interface styles 
(colors, tab shapes, buttons) have changed along 
with the addition of some great new features that are 
integrated into the new version of Premiere Pro. Those 
new features are pretty impressive and the new tools 
are sure to save you valuable time (as well as some 
gray hair) and enhance your creative process. You can 
now exploit the full potential of tapeless workflows, 
efficiently manage and find assets by using metadata 
throughout production as well as utilizing more than 
50 of the most requested editing enhancements to 
streamline your workflow and maximize your creative 
options. What are the top new features? 

top neW features

• Next-generation tapeless camera support 

• Batch encoding 
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cal. This is where the Media Encoder comes in and 
saves you time by automating the process of creating 
multiple versions of your source files and Premiere Pro 
sequences.  Media Encoder also encodes composi-
tions from After Effects when it’s part of the Produc-
tion Premium CS4 install. Use any combination of 
sequences and clips as sources, and encode to a wide 
variety of video formats, including FLV and F4V, Win-
dows Media, MPEG-2, H.264, QuickTime, and more.

Use Adobe Media Encoder to batch encode a 
wide variety of video formats with any combination of 
sequences and clips as sources.

improved adobe integration

Sharing media between pre- and post-production 
software tools used to require you to render your work 
in one application before importing it into another, 
which was an inefficient and time-consuming pro-
cess. If you needed to make changes, you had to 
make them in the original application and re-render 
the asset. Innovative Adobe Dynamic Link, previously 
available only in Adobe Creative Suite Production 
Premium, streamlines this process. Dynamic Link 
elimi¬nates the need for intermediate rendering by 
creating a direct link between new or existing assets in 

ture, you can Access the footage you want before you 
import it by viewing camera metadata and organizing 
files in the Media Browser.

Locate and open footage easily with the new Media 
Browser panel, which lets you drag and drop files to 
the Project panel, preview them in the Source Monitor, 
or add them to a sequence in the Timeline. Notice how 
P2 clips can be viewed as video clips or as a group of 
file folders (inset).

batch encoding

We have all seen it. With the explosion of video 
sites like YouTube and others like it, the industry is 
realizing in huge numbers there has been in shift in 
how people view video entertainment. Whether you 
are doing podcasts or creating your own roughs, being 
able to output to a variety of formats is absolutely criti-

premiere cs4 premiere cs4
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instantly as you type. Manage projects more efficiently 
by saving file-location preferences on a per-project 
basis, making it easier to set up partitions for particu-
lar projects. Update assets in your project quickly as 
newer versions become available by replacing files 
in the Project panel; when replacing assets, all clip 
instances of that media update automatically. Combine 
content from multiple projects easily with the ability 
to import sequences from other projects. Choose any 
combination of sequences to import; Premiere Pro 
includes all nested sequences, helping to ensure that 
all content is imported successfully.

Create workspace configurations using Project-
panel column configurations optimized for the task at 
hand. For example, set up different columns for log-
ging and for editing.

Premiere Pro CS4 lets you delete individual 
preview files, mak-
ing it easy to reclaim 
disk space. Keep the 
preview files you need, 
and discard the ones 
you don’t.

Quickly find what 
you’re looking for by 
typing its name into 
the Search box in the 
Project panel (shown 
here) or in the Effects or 
Metadata panel.

superior editing control

Use Track Sync Lock controls to select which 
tracks remain in sync after ripple and insert edits. Dis-
play source content of clips, route channels to specific 
destination tracks in the Timeline, and toggle video or 
audio channels on or off as needed with source-con-
tent controls. Place clips exactly where you want them 
when dragging to the Timeline. Innovative ways to tar-
get audio and video tracks provide multiple methods to 
control clip placement, saving you time and preserving 
the placement of other clips in the Timeline. Drag and 
drop video- or audio-only portions of clips onto any 
combination of compatible destination tracks.

Premiere Pro CS4 and Encore CS4. Changes made in 
Premiere Pro such as color corrections and so on are 
immediately reflected in Encore.

With Dynamic Link, you can modify a sequence in 
Adobe Premiere Pro and see it update immediately in 
Encore with no need for rendering. In Adobe Creative 
Suite 4 Production Premium, the expanded Adobe Dy-
namic Link saves time on every project by dynamically 
linking content between After Effects, Adobe Premiere 
Pro, Soundbooth, and Encore. 

There are many other integration enhancements in 
Premiere Pro CS4 that include:

flexible photoshop layer options

 Control exactly how Photoshop files look when 
imported into Premiere Pro. Preview all layers, choose 
which layers to import, and then choose how to import 
them—as individual layers, merged, or as a sequence.

Support for Photoshop files with video. Avoid the 
extra rendering step from Photoshop when import-
ing PSD files that contain video. Simply import the 
files and use them just like any other video clip in the 
Timeline.

Support for Photoshop blending modes. Match 
your favorite looks from Photoshop by applying Pho-
toshop blending modes to clips on the Premiere Pro 
Timeline. Blending modes are available for all clips, 
and are fully keyframeable. When importing Photo-
shop PSD files, blending modes are automatically 
carried over into Premiere Pro.

Enhanced editing efficiency

Work faster with powerful and flexible editing 
enhancements. Premiere Pro CS4 includes over 50 
of the most requested editing enhancements that 
streamline your workflow. Display search results quick-
ly. Apply effects to multiple selections, get timecode 
information faster, speed up work in the Timeline with 
new keyboard shortcuts, and much more.

Powerful management of projects, sequences, and 
clips

Find content quickly and efficiently by typing what 
you’re looking for into the Search box in the Effects, 
Project, or Metadata panel, and see results update 



58

premiere cs4 premiere cs4

Source Monitor. Premiere Pro CS4 gives you the flex-
ibility to navigate your content quickly and efficiently.

enhanced keyboard-driven WorkfloW

Point-and-click, mouse-based operation is a simple 
and easy way to learn new software. But experienced 
users want to navigate and control their tools as 
quickly and efficiently as possible. Premiere Pro CS4 
offers complete, mouseless operation via customizable 
keyboard shortcuts, to help you focus on being cre-
ative. Use keyboard shortcuts to browse through clips 
loaded in the Source Monitor tab and to save time 
when moving to the start and end of clips in the Effect 
Controls panel. Jump to the start and end of clips in 
the Timeline using dedicated shortcuts that make clip 
navigation easy. You can assign shortcuts to mark 
clips more quickly and to cycle forward and backward 
through all the panels in the Adobe Premiere Pro CS4 
user interface.

project intelligence With neW xmp metadata 

support

Metadata is the unsung hero of an efficient work-
flow, and the key to the perennial challenge of making 
video searchable. You have great footage, but do you 
know where it was shot, who the talent is, and if you 
have the rights to use it? And more important, can 
you—and your viewers—find the video content that’s 
most relevant? Premiere Pro CS4, OnLocation CS4, 
and Encore CS4 deliver innovative, industry-leading 
solutions that solve both problems. 

Careful planning keeps your productions on 
schedule and on budget. During preproduction, block 
your scenes, plan camera moves, and create a shot 

timesaving editing enhancements

When you paste multiple clips into the Timeline, 
the playhead jumps to the end of the pasted clip so 
that subsequent clips are placed directly after, saving 
you time. Create new subclips quickly and easily by 
simply dragging content directly from the Timeline to 
the Project panel. Place keyframes precisely within the 
Effect Controls panel. As you move them, keyframes 
snap to sequence markers, the playhead, clip edges, 
or other video or audio keyframes. This makes it 
simple to align new keyframes with existing ones. Use 
vertical snapping to keep clips in sync when moving 
them between tracks. Easily apply the same transi-
tion to multiple items in your project by copying and 
pasting the transition. Premiere Pro CS4 applies all 
transition information, while maintaining destination 
attributes such as transition duration. 

Use smart zoom features in the Timeline to switch 
quickly between detailed and global views of your con-
tent. Simply press a key to zoom the Timeline to show 
the entire contents of your sequence, and then press 
another to return to the previous zoom level.

Quickly clear all effects from one or multiple se-
lected clips using a single command.

audio control

Finding specific sonic events in your audio 
tracks—for example, the start of a sentence, a car 
door slamming, or the downbeat in your soundtrack—
is often a simple matter of looking for peaks and val-
leys in their waveforms. New features in Premiere Pro 
CS4 let you view audio waveforms in more detail in the 
Source Monitor. Zoom both channels independently 
or together. Navigate with precision within the Source 
Monitor when working with audio-only clips. Use the 
playhead to scrub the waveform directly. Change 
batch capture behavior easily by setting and adjusting 
audio-channel mapping for offline clips at any time, 
when or after they are created. You can also recapture 
offline clips as audio-only or video-only by changing 
recapture settings for offline clips, without having to 
recapture them first. 

Zoom in on audio waveforms in different chan-
nels together or, as shown here, independently in the 
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list to plot your shooting 
sequence and fill in metadata 
associated with each shot. 
Bring your careful planning 
on-set by creating a shot list 
in Adobe OnLocation. While 
you’re recording footage 
directly to disk, OnLoca-
tion automatically captures 
important metadata-based 
project intelligence associ-
ated with each shot coming 
from the camera. Create new 
takes each time you re-record, with each take inheriting 
metadata from the master shot. You can even edit or 
add to the metadata while you’re at the shoot.

During post-production, you can use metadata to 
streamline project tracking, asset auditing, and many 
other formerly tedious manual tasks in Adobe Premiere 
Pro CS4 and Encore CS4, as well as in Adobe Sound-
booth CS4, After Effects CS4, and Adobe Flash CS4 
Professional software. Best of all, as other workgroup 
members modify files and assets, metadata-based proj-
ect intelligence associated with each media asset can 
be edited and updated in real time during the normal 
course of production.

Save even more time by eliminating the need to 
hunt from folder to folder to track down assets. Meta-
data makes your assets searchable within the Adobe 
Premiere Pro CS4 Timeline, so you can locate assets 
and clips by filename, date, time, camera setting such 
as resolution or frame rate, shot location, or any other 
search term you’ve added to your asset or clip.

speech search makes dialogue in your video 

assets searchable

This has to be one of the coolest new features in 
Premiere Pro! You can now use the new Speech Search 
technology in Premiere Pro to turn your spoken dialogue 
into text-based metadata that makes you video search-
able. Here is how it works. This new feature automati-
cally turns any spoken word into a keyword that points 
to the exact point in a clip where that word is spoken. 
This is great news for post production pros and all of us 

who watch video online. Speech 
Search will greatly benefit the edit-
ing process as creative pros will be 
able to locate the relevant points 
in a particular clip based on what 
gets said within the clip. Another 
important note is that , the time-
accurate text that corresponds to 
spoken words is embedded in the 
output you render from Adobe 
Premiere Pro CS4, so your video 
is searchable by other tools that 
can read XMP metadata, such as 

search and indexing engines.

In Premiere Pro, Speech Search can significantly 
speed the time-consuming process of wading through 
large quantities of footage to find the relevant clips. For 
example, you can quickly find all of the clips in a project 
that contain a particular word, or the opening lines of a 
scene from the script you’re shooting, by searching from 
the Project panel. Once you’ve narrowed your search, you 
can search within a particular clip for a word or phrase by 
using the Source Monitor, or you can skim the preliminary 
transcript that appears in the Metadata panel. Both ap-
proaches are significantly faster than manually scrubbing 
through a clip to find, for example, the spot in a long in-
terview where the subject talks about a transformative trip 
to Zambia. Additionally, you can tab from word to word in 
the Metadata panel to make edits while ensuring that text 
remains synchronized to the spoken word.

Well that gives you a good overview of the dynamic 
new features in Premiere Pro CS4. I for one am im-
pressed with the new features and definitely will be 
upgrading to take advantage of what CS4 can do for my 
productivity and creativity. 

 Bruce Bicknell is a video and animation specialist who is the 
founder of Digital Blue Productions. He has been an instructor on 
Adobes in-box training as well as published in Photoshop User, 
Layers Magazine, ATI Red, MacTribe and PhotoshopCAFE. His 
clients include Time Inc., DTCC, KW Media and has worked with 
magazines that include People, National Geographic, Adventure, 
Photoshop User,  and Layers magazines to name a few. Bruce is 
also an instructor at Sessions.edu teaching video and graphics 
courses.    
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Timeline panels, 
allows you to type in 
any keyword or file 
type you’re looking 
for and the results 
are instantly visible 
in the panel below. 
Even those files that 
are nested deep in-
side subdirectories 

and precomps are visible in the Project panel. 

The QuickSearch in the Timeline panel will re-
veal layer properties such as rotation or position at a 
glance, so you don’t have to manually flip-down the in-
dividual arrows inside each layer’s properties to locate 
them all. As a working producer of large media-heavy 
projects, involving often hundreds of files and layers, 
this feature alone is going to save me a LOT of time 
and frustration while working on tight deadlines!

nested compositions With the composition 

navigator

When you’re working on a project that requires 
a series of nested precomps or a build up of other 
compositions and media, then tracking that path back 
can be difficult and time-consuming. The new Compo-
sition Navigator shows you the Mini-Flowchart with the 

premiere cs4

after effects cs4
Jeff Foster - pixelpainter.com

at a glance

The Adobe After Effects® development team has 
once again produced a significant major upgrade 
with the CS4 version. It’s not just a bunch of shiny 
new plug-ins and fancy gimmicks, but truly useful UI 
production features and other CS4 product integration 
that makes serious project workflow for the motion 
graphics artist more seamless. Much-needed produc-
tion features such as keyword-searchable timelines 
and projects and nested composition navigation. 
You can now export rich media from After Effects to 
Adobe Flash® CS4 Professional, retaining layer and 
keyframe data for further editing. XMP metadata can 
now be added throughout your After Effects projects 
and maintained in the final render, for improved asset 
management and copyright tracking. They’ve also 
added integrated workflows for mobile-device author-
ing – giving you previews of what your content will look 
like when displayed across several devices.

But don’t think they’ve skimped on the new 
creative features, mind you! You can import 3D lay-
ers created in Adobe Photoshop® CS4 Extended and 
control 3D space with improved X-, Y- and Z- position 
keyframes. Apply the Cartoon effect to create simulat-
ed cel animation from live footage. 2.5D planar motion 
tracking has made a huge leap with the inclusion of 
Imagineer Systems’ Mocha for Adobe After Effects, 
eliminating the guesswork and often disappointing 
results from hand-tracking footage. This really is a 
significant upgrade for the serious motion graphics 
producer!

quicksearch for the project & timeline pan-

els

The new QuickSearch box on both the Project and 
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names of all the incoming (nested) compositions, as 
well as the outgowing (parent) compositions. 

You can click-
through the path for-
ward and backwards 
to reveal the names of 

all the sub-elements of the master composition.

importing photoshop cs4 extended 3d layers

You can now import and animate Photoshop 3D 
layers in After Effects CS4. The 3D objects are im-
ported as Photoshop layers but they still retain their 
full volumetric space – not just a 2D snapshot from a 
predetermined angle from Photoshop. Cameras can 
be animated around them as well as any other 3D 
layer in After Effects, but since the 3D layer is still after 

all, a layer, effects 
like distortion or 
other filters can be 
applied to them 
over time. 

Photoshop CS4 3D layers can be imported and manipulated in 
3D space in After Effects CS4 – retaining all the 3D modeling and 
surface data from the original layers. 

unified camera tool

Selecting the Unified Camera Tool from the upper 
composition takes advantage of a multi-button mouse 
to fully control basic camera moves – allowing you to 
zoom, rotate and move around a 3D scene quickly 
with ease.

Separate X, Y, and Z Positioning

Simulated crane and camera moves can be cre-
ated more easily with the ability to keyframe separate 
X-, Y-, and Z- position properties. These can be broken 

after effects cs4

production WorkfloW enhancements
Adobe has really paid attention to the input of motion 

graphics and video producers with the introduction of even 
more advanced productivity boosters provided in After Ef-
fects CS4. Some of these new enhancements include:

• Center Cut Safe areaS

When working in 16:9 (widescreen) compositions, the Ti-
tle/Action Safe overlays also now show the 4:3 center cut safe 
area, so you can determine if your composition will be framed 
correctly when cropped and edited for 4:3 standard def.

• auto reSolution

There is now an Auto Resolution/Down Sample Factor 
menu item on the Composition panel, which calculates reso-
lution based on the current zoom level, which optimizes your 
performance by not rendering pixels that aren’t visible.

• advanCed MeMory ManageMent

You can now select how much RAM is being allocated to 
After Effects and other applications, as well as how much of the 
Multiprocessor usage is going to be applied and how much of 
the memory will be used by OpenGL. This really takes advan-
tage of today’s more powerful multiprocessor computers! 

• longer layer and CoMpoSition naMeS

You are no longer restricted to the 31 character limits to 
layers and composition, allowing you hundreds of charac-
ters to provide details of that particular element’s contents.

• opengl adaptive reSolution

Larger images and complex scenes are temporarily sub-
sampled allowing immediate visual feedback to adjustments.
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neW integration With flash cs4 professional

In After Effects CS4, compositions can be exported 
as layer projects (XFL files) that can then be imported 
into Flash CS4 Professional and edited with all their 
properties. FLV, PNG and JPG source footage files 
are passed on to Flash Professional without further 
transcoding. Animated transformations such as scale, 
position and rotation are preserved in the layers and 
can be further edited in Flash Professional. Other me-
dia files and layers with effects attached are converted 
to file types compatible with Flash.

In addition to the new XFL export feature, After 
Effects already supports the ability to embed Flash 
cue point information inside its layer and composition 
markers. This means you can use scripting to embed 
the results of motion tracking, expressions and key-
frame assistants in After Effects, into media that can 
be accessed inside of Flash.

imagineer mocha for after effects cs4

New with After Effects CS4 is a motion tracker 
provided as a stand-alone application, called Imagi-
neer Systems’ Mocha for After Effects. This powerful 
2.5D planar motion tracker works better than the 
point-based trackers on problem footage that has 
objects move out of frame or poor lighting conditions 
that leave little detail or excessive noise that can prove 
difficult to otherwise track.

out into separate dimensions and controlled inde-
pendently of each other, including editing along the 
Timeline with the Graph Editor. 

neW cool effects!

Of course, no release of After Effects would be 
complete without... EFFECTS! After Effects CS4 is no 
exception and includes some great new stylish effects 
featuring:

cartoon effect

Quickly apply the effect of cel painted animation to 
your live action video footage or other animated com-
positions. This effect is much more than just a “water-

color” filter, but 
really smoothes 
and enhances 
the edges and 
soft gradients 
without being 
distracted by 
minute details 
in the footage.

bilateral blur effect

Similar to a “Smart Blur” effect, the Bilateral Blur 
uses edge detection to preserve sharp edge details 
while further softening smooth surfaces with less con-
trast in the original footage. It does however, desatu-
rate color significantly, but creates a great “Film Noir” 
effect.

turbulent noise effect

Using fractal-derived noise, this effect can create 
some stunning natural effects beyond that capable 
with just particle effects. Simulate clouds, fog, smoke, 
fire, light rays, plasma and much more! 

after effects cs4 after effects cs4
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xmp metadata neW to after effects cs4

This may not be the sexiest tool in the bag, but for 
producers of mass content and large productions, it’s 
quite possibly the most important one! Asset manage-
ment and tracking, copyright and royalty manage-
ment and project management can be much more 
easily controlled through the information that passes 
along from the source materials and media to the final 
delivered product. Copyrights of a song or image file 
can be passed through the process and incorporated 
in the final composed video or Flash media. Even 
Marker metadata can be preserved on a timeline from 
a project and the rendered movie can retain this data 
when imported back into After Effects CS4.

final thoughts

As someone who has watched After Effects evolve 
over the years (I’ve been producing motion graphics 
and animations with it since it was known by its origi-
nal developers as “CoSA After Effects”) I’ve seen some 
significant improvements and changes in this applica-
tion. By far, this is probably one of the most useful 
versions with much needed improvements, in Adobe 
After Effects development history – and will most 
certainly be the most appreciated by serious industry 
professionals since version 7, as far as UI design work-
flow, speed and usability. The new UI is even more 
compatible for use on a Wacom Cintiq tablet, with less 
need to get the pull-down menus from the top menu 
bar – which speeds productivity as well.

That said, the only negatives that I can see in this 
version (if you can actually call them that):

•	Requires	Intel	multiprocessors	(no	Power	PC/G5/G4	compatibility)

•	Still	no	real-time	previews	like	Apple	Motion®

•	Mocha	is	a	stand-alone	application	with	a	steep	learning	curve	
(ok - we can live with that for now!)

This is a MUST-HAVE upgrade for motion graphics 
professionals! If you haven’t gone out and upgraded 
to a Dual-Intel powered Mac/PC by now, then THIS is 
your excuse to do so... NOW!

Jeff Foster has been producing and training for traditional and 
digital images, photography, illustration, motion graphics and 
special effects for DV and Film for over 20 years. He has authored 
several books and spoken at big Industry events. PixelPainter.com

After Effects CS4 comes packaged with Imagineering Systems’ 
Mocha for After Effects; a professional stand-alone application 
that handles motion tracking beyond the point trackers that are 
built into After Effects.

Once you’ve tracked an object in Mocha, the 
tracking data is then exported for use in After Effects 
to attach to corner pin data. The results are clean and 
amazing, though the stand-alone application can be a 
bit intimidating and the learning curve may take awhile. 
My feeling is that Adobe may some day incorporate this 

stand-alone application 
into After Effects in sub-
sequent versions, but 
for now, it’s still amazing 
that it is included with 
the CS4 package!

mobile devices authoring WorkfloW With 

adobe device central® cs4

With so many designers having to produce media 
for mobile device delivery, it can be frustrating and 
very time consuming having to produce over and over 
again for the wide variety of devices out there. This 
is where the union of After Effects CS4 and Adobe 
Device Central CS4 come into play. Their workflow em-
braces the “author once/deliver many” concept and 

nobody 
else can 
claim that 
promise.

after effects cs4
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ing icons in the upper left area of the window. The first 
allows you to navigate to a recent file or folder:

You may also use these 
icons to download images di-
rectly from your camera, Refine 
the selected contents (Batch 
Rename, tweak the file informa-
tion) open image4s in Camera 
Raw or process the folder con-
tents for output to Web of PDF.

In the upper right you have additional Bridge op-
tions, one of which (the Star icon) allows you filter the 
images in Bridge that you would like to see; you may 
do this by rating, view rejected files, labeled and un-
labeled items. This simply helps you view images that 

you have assigned a 
specific criteria such 
as a star rating (1-5), 
which can be incredi-
bly helpful when work-
ing in a folder of a few 
hundred images.

One of the features I look for in any program is 
its ability to be customized to my workflow. I get very 
annoyed when the software company defines my 
workflow for me. In Bridge this isn’t a problem, as you 
can literally control nearly everything in the program. I 

cs4 bridge
Al Ward - www.actionfx.com

The Adobe CS4 Suite is, quite frankly, the best 
software bundle produced by Adobe to date, and I’m 
not exaggerating by any stretch of the imagination. 
This incarnation of the Suite goes farther than any 
previous, not only in updating the individual programs, 
but in tying them together to work seamlessly between 
programs such as Photoshop, Illustrator, Dreamweav-
er, Flash so on and so forth.

There is absolutely no way I can cover a fraction of 
the features in detail in the space I have available, so 
this is simply a quick overview of Bridge. We start with 
the basic interface when Bridge is opened.

As with previous versions you have multiple views/
layouts to choose from, but the default looks like the 
image above, with a general 3 column format: Naviga-
tion in the upper left, Filter and Collections information 
on the lower left, Folder Contents view in the center, 
and preview/image information on the right hand side. 

You have a few additional Navigation/File Process-
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bridge cs4

I can even access Flash videos I’ve created and 
not only see the file inside Bridge, but play them in 
Bridge as well.

You can still use the Batch processing feature in 
Photoshop from within Bridge (which allows you to 
play an action on a folder of images or selected files), 
as well as Merge to HDR, Photomerge, convert images 
selected in Bridge to a layered PSD file in Photoshop, 
and a host of wonderful little tricks.

Ok, I’ll be the first to admit this little article simply 
does not do justice to the software. I will tell you that 
you will be pleasantly surprised when you open up 
Bridge and see for yourself the features and control 
the software gives you over you files and how it can 
help streamline your workflow. I simply love it.

That’s it for now… I hope you enjoy it. Stay tuned 
at http://www.actionfx.com as the first of the Photo-
shop CS4 presets are on the way. I’ve over 113,000 
custom presets there at this writing, with more in the 
works. Until next time, take care!

Al Ward has authored many books. He runs the world’s top Pho-
toshop add-on site, with actions, presets, brushes, textures and 
more. www.actionFx.com.

could spend 50 pages simply on the preferences avail-
able to you in Bridge, and since we simply don’t have 
the space for that here I ask you to look at the fol-
lowing screen captures. They should give you a fairly 
decent idea of the level of adaptability Bridge has for 
your particular workflow requirements.

As with previous versions you can alter the viewing 
window to suite your tastes.

For those of you who 
work with Panoramas 
and/or HDR images, the 
Stacks menu allows you 
to work with these directly 
from Bridge.

One of the main things I appreciate about Bridge 
is the ability to work with Adobe’s other programs, 
which is of particular use to me as a web designer 
in that I can access my HTML and Flash files from 
within Bridge, allowing me to effortlessly work between 
Photoshop and Dreamweaver, Photoshop and Flash, 
or whichever programs in the Suite that I utilize side 
by side on a regular basis.
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brance adjustment and a pressure sensitive pen deliv-
ers unprecedented control against over-saturation and 
thus clipping. For example, selectively increasing the 
saturation of a field of flowers, or other colorful scenes.

improved tools of the trade

Like many tasks in Photoshop, there are numerous 
ways to arrive at the end result. Some ways are more 
favorable than others. One of the more highly debated 
tasks is how best to lighten and darken portions of an 
image. Historically considered destructive, the Dodge 
and Burn tools are looking to get a bit more respect 
among retoucher’s in CS4. And I say they deserve it! 
Certainly when applied to an overall image layer, they 
can be destructive, but consider their application with 
a pressure sensitive pen… Setting the brush so that 
opacity is controlled by pen pressure, the improved 
Dodge and Burn tools produce a more natural lighten-
ing and darkening effect by preserving the hue of the 
area being painted. An excellent choice when the job 
calls for “get it done, fast and clean”. The Sponge tool, 
which shares a square with Dodge and Burn in the 
Tool panel, gets an upgrade as well. A check box on 
the Options bar enables you to take advantage of the 
benefits found in the Vibrance adjustment. Think of it 
as a “Vibrance Brush”!

enhanced image “manipulation”

For those that manipulate images—I mean really 
“manipulate” images—drawing or painting brisk 
strokes, panning, zooming and otherwise tossing im-
ages around for review, you are going to love CS4’s 

What’s neW for Wacom pen 
tablet users in photoshop cs4?
Weston Maggio - wacom.com

It should go without saying that with each version 
of an application comes new and improved features 
over the last. Let me confirm it for you… In Photoshop 
CS4, Adobe outdoes themselves—particularly for Wa-
com pen tablet users! The latest and most feature-rich 
version of Photoshop ever brings enhancements that 
will please the most savvy tablet users and appeal to 
those looking to add a tablet to their creative workflow.

streamlined editing performance

From the start, CS4 offers the tablet user a new ap-
plication window from which to work. This new frame 
work offers a tab-based interface with self-adjusting 
panels to keep our tools out of the way so that we 
can stay better focused on our images. That’s right, 
“panels”. Gone are the use of the word “palettes” and 
their multi-click functionality. New, panels enable us to 
apply our enhancements more intuitively and in fewer 
steps.

Of particular interest are the new Adjustment and 
Mask panels. Rarely does an image cross my desktop 
and not get some sort of adjustment. Whether they 
are to make a simple shift in tonal vale, or a more 
sophisticated color correction, adjustments (and their 
associated layer masks) are a staple in my workflow. 
Now you can apply adjustments as Adjustment Layers 
with a single click and a slide in the Adjustment panel. 
Then, using a pressure sensitive pen, you can selec-
tively apply that adjustment to the areas that you want 
with a great level of control.

Speaking of adjustments, we get a new one in 
CS4: “Vibrance” gives the user greater control over the 
saturation of color, preserving delicate tones, such as 
those found in foliage. The combination of the Vi-
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new image-viewing performance.

Leveraging the power (aka GPU) found in modern 
day computers, PSCS4 can really crunch the numbers 
associated with drawing (and redrawing) images on 
the screen rapidly. This is most visible through a swift 
stroke of a brush/pen across a tablet. Crisper, more re-
sponsive lines result in a glorious drawing experience. 
Add to this, a new dynamic brush resizing feature 
and fluid canvas rotation, and you’ve got an illustra-
tion powerhouse! But photographers and designers 
fear not, this power isn’t just reserved for those with 
drawing skills! Anyone that pushes pixels around will 
totally appreciate CS4’s graceful panning and zoom-
ing motions. (Users of Apple’s iPhone will immediately 
find the “gliding” motion familiar.) With the Hand tool 
selected, you can literally “flick” your image in any 
direction with your pen. 

Last but certainly not least; I can’t leave off a neat 
little feature called Spring-loaded keys. Relatively 
simple, Spring-loaded keys enable you to temporarily 
switch between tools by holding down a tool shortcut 
key. Releasing the key after use of the secondary tool, 
snaps you back to the original tool that you were us-
ing. Very cool! 

Bottom Line: If you currently use a Wacom pen 
tablet, you are going to love Photoshop CS4’s per-
formance. With  its enhanced interface, improved 
toolset and streamlined graphics handling, you’ll see 
an almost immediate boost in productivity. If you’ve 
not yet experienced the benefits of a pen tablet, the 
new features in CS4, combined with its legacy pen-
centric functionality, make a most compelling case to 
add one to your workflow. You owe it to yourself to turn 
on, and take advantage of the wide set of features in 
Photoshop designed specifically for Wacom pen tablet 
users.

About the Author: An Adobe Certified Expert in Photoshop and 
Application Specialist for Wacom Technology, Weston Maggio 
is an authority on Photoshop instruction. Wes can be regularly 
found lecturing and instructing experts-to-enthusiasts alike at 
creative events around the country. For more information about 
Wes, check out his website at www.westonimages.com. To learn 
more about Wacom and their line of pen tablets, please visit 
www.wacom.com. 

community spotlight

photoshopcafe.com

Join with thousands of other people that are just as 
crazy about visual imaging as you are! Discuss the lat-
est trends, ask questions and show off your knowledge 
by answering a few yourself. Get feedback on your 
work in progress.

We have a huge annual contest with over $12,000 
worth of prizes. We also have friendly battles and 
CAFE crew projects on an ongoing basis. Join the 
“friendliest forum on the web.” Be careful though, this 
place is addictive as coffee.

www.photoshopcafe.com/cafe

renderosity.com

Become part of the largest digital art community 
on the web at Renderosity!  Upload your artwork 
into our member galleries.  Learn to hone your craft 
with our video tutorials.  Sell your products in our 3D 
marketplace.  Download free stuff.  Interact in com-
munities built around every major piece of design 
software available today.  Keep up to date on all the 
latest industry news.  Enter our annual contests to win 
thousands of dollars in prizes.

 We have something for everyone, from the ev-
eryday hobbyist to the professional developer.  There 
are communities for applications such as Photoshop, 
Corel, 3DSMax, Maya, Lightwave, Blender3D, Cin-
ema4D , Z Brush and many others.  Interact with 
experts in the field of 3D design, photography and 
image manipulation.

Renderosity was founded 
in 1998 as a Poser forum, 
and has since grown to over 
half a million members who 
use a variety of 2D and 3D 
applications, from Adobe 
Photoshop to Z Brush, and 
everything in between.

T H E  U L T I M A T E  I N  P H O T O S H O P  T R A I N I N G

If you run an online community that you would like considered in 
the community spotlight, shoot us an email.


